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Kata Pengantar

Peningkatan kualitas pendidikan saat ini menjadi prioritas, baik oleh
pemerintah pusat maupun daerah. Salah satu komponen yang menjadi fokus
perhatian adalah peningkatan kompetensi guru. Peran guru dalam
pembelajaran di kelas merupakan kunci keberhasilan untuk mendukung
keberhasilan belajar siswa. Guru yang profesional dituntut mampu
membangun proses pembelajaran yang baik sehingga dapat menghasilkan

output dan outcome pendidikan yang berkualitas.

Dalam rangka memetakan kompetensi guru,telahdilaksanakan Uji Kompetensi
Guru (UKG). UKG dilaksanakan bagisemua guru, baik yang sudah bersertifikat
maupun belum bersertifikat untuk memperoleh gambaran objektif

kompetensi guru, baik professional maupun pedagogik.

Dan sebagai upaya untuk melakukan perbaikan pengetahuan dan
ketrampilan profesional secara terus menerus selain pelatihan dasar yang
diperoleh sebelumya, maka akan diselenggarakan pendidikan dan pelatihan

pengembangan keprofesian berkelanjutan (PKB).

PPPPTK Matematika sebagai Unit Pelaksana Teknis Kementerian Pendidikan
dan Kebudayaan dibawah pembinaan Direktorat Jenderal Guru dan Tenaga
Kependidikan mendapat tugas untuk menyusun modul guna mendukung
pelaksanaan diklat PKB. Modul ini diharapkan dapat menjadi sumber belajar
bagi guru dalam meningkatkan kompetensinya sehingga mampu mengambil

tanggungjawab profesi dengan sebaik-baiknya.

Yogyakarta, Desember 2015
Kepala PPPPTK Matematika
ttd

Dr. Daswatia Astuty
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Kegiatan Pembelajaran 1

Pengenalan OpenOffice

A. Tujuan

Tujuan kegiatan pembelajaran ini adalah Peserta dapat menggunakan

OpenOffice untuk pengembangan diri dan aktivitas profesinya.
B. Indikator Pencapaian Kompetensi

Setelah menyelesaikan pembelajaran ini peserta dapat:
¢ menginstal OpenOffice,
e menjelaskan fitur-fitur OpenOffice,

¢ membuat dokumen Writer.
C. Uraian Materi

Guru mempunyai peran sangat penting dalam pendidikan, sehingga guru
harus mempunyai kompetensi yang baik untuk menjalankan profesinya. Oleh
karena itu melalui Peraturan Menteri Pendidikan Nasional No 16 tahun 2007
Pemerintah menciptakan standar kompetensi yang harus dipenuhi guru yang
meliputi kompetensi pribadi, professional, pedagogik dan sosial. Konsekuensi
dengan adanya regulasi tersebut adalah guru harus terus melakukan
pengembangan diri untuk mencapai standar kompetensi tersebut dan dalam
rangka memberi layanan pendidikan yang terbaik untuk anak didiknya.

Dalam standar kompetensi pedagogik, disebutkan bahwa guru harus dapat
memanfaatkan teknologi informasi dan komunikasi (TIK) untuk kepentingan
pembelajaran. Dalam standar professional juga disebutkan bahwa guru harus
dapat memanfaatkan teknologi informasi dan komunikasi untuk
berkomunikasi dan mengembangkan diri. Mengingat tuntutan regulasi
tersebut dan juga adanya implementasi kurikulum 2013 yang
mengamanahkan pembelajaran dengan menggunakan berbagai sumber

belajar, maka guru harus meningkatkankemampuan dan penguasaanya
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terhadap TIK. Guru hendaknya mengikuti perkembangan TIK sehingga dapat
mengarahkan anak didiknya pada suasana belajar abad 21. Alasan lain yang
tidak kalah pentingnya adalah dengan penguasaan TIK guru dapat
menyampaikan pembelajaran dengan berbantuan TIK sehingga suasana
belajar diharapkan lebih menyenangkan. Oleh karena itu guru perlu dibekali
dengan pengetahuan tentang TIK dan pemanfaatannya untuk pembelajaran.
Melihat kondisi saat ini masih banyak guru-guru atau masyarakat Indonesia
secara umum yang menggunakan software aplikasi perkantoran berbayar
secara ilegal untuk kepentingan pengembangan diri dan melaksanakan tugas
profesinya, sedangkan di sisi lain sudah banyak aplikasi perkantoran open
source yang bebas dan gratis dipakai siapapun untuk kepentingan apapun,
termasuk kepentingan pendidikan. Hal ini mendorong untuk mengenalkan
guru kepada aplikasi perkantoran open source, dengan harapan selanjutnya
guru dapat menguasai dan memanfaatkan untuk pengembangan diri dan
melaksanakan tugas profesinya. Salah satu aplikasi perkantoran open source
adalah OpenOffice.

Apa Itu OpenOffice?

OpenOffice adalah software open source untuk pengolah kata, pengolah
angka, presentasi, gambar dan basis data. OpenOffice merupakan salah satu
pionir yang menguasai dunia aplikasi perkantoran open source. Dengan
sifatnya yang open source, setiap orang bisa mempunyai dan menggunakan
OpenOffice secara gratis dan legal. OpenOffice mempunyai antarmuka dalam
banyak bahasa dan dapat diinstalasi pada semua platform sistem operasi.
Kelebihan lain yang dimiliki OpenOffice adalah mampu menyimpan data
mengikuti format dokumen terbuka standar international sehingga tidak ada
masalah apabila akan dilakukan pertukaran file. Untuk mendapatkan
software OpenOffice dapat didownload melalui website OpenOffice.org.
OpenOffice mempunyai fitur layanan sebagai berikut.

e  Writer, merupakan fitur untuk pengolah.

e (Calc, merupakan fitur untuk pengolah angka.
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Impress, merupakan fitur untuk membuat presentasi.
Draw, merupakan fitur untuk menggambar.
Base, merupakan fitur untuk basis data.

Math, merupakan fitur untuk menulis formula matematika.

Keuntungan menggunakan OpenOffice

Dengan dukungan fitur dan sifatnya yang opensource, OpenOffice memiliki

kelebihan-kelebihan yang bisa dinikmati oleh penggunanya, diantaranya

sebagai berikut.

Kualitas handal

OpenOffice merupakan software opensource yang telah dikembangkan
selama lebih kurang 20 tahun sehingga menjadikan OpenOffice sebagai
software yang dapat diandalkan dengan kualitas yang baik.

Konsistensi antarmuka

OpenOffice mempunyai antarmuka yang konsisten pada setiap versi
software sehingga perkembangan versi software tidak menyulitkan
pengguna untuk beradaptasi.

Paket bahasa yang banyak

Adanya pilihan paket bahasa yang banyak memberikan keleluasaan
kepada pengguna OpenOffice untuk memilih bahasa apa yang akan
digunakan.

Multiplatform

OpenOffice dapat dijalankan pada komputer dengan platform Microsoft
Windows, GNU/Linux, Sun Solaris, Apple Mac.

Gratis

OpenOffice merupaka software opensource dibawah lisensi Apache 2.0
Licensesehingga OpenOffice bisa didownload dan digunakan oleh
siapapun untuk kepentingan pribadi, umum, pendidikan maupun bisnis
tanpa harus membayar sejumlah uang untuk lisensi. Bahkan pengguna

juga dapat memberikan kontribusi untuk pengembangan OpenOffice.



http://www.apache.org/licenses/LICENSE-2.0.html
http://www.apache.org/licenses/LICENSE-2.0.html
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Bebas
OpenOffice menjamin penggunanya bebas dari tuntutan hukum karena
penggunaan software illegal. Karena OpenOffice software legal yang

bebas digunakan oleh siapapun di bawah lisensi Apache 2.0 License.

Dengan kelebihan-kelebihan tersebut di atas cukup menjadi alasan bagi calon

pengguna untuk segera beralih menggunakan OpenOffice.

OpenOffice Writer

Salah satu fitur yang dimiliki OpenOffice untuk pengolah kata adalah

OpenOffice Writer. Writer memiliki kemampuan yang baik untuk sebuah

pengolah kata. OpenOffice mempunyai fitur standar aplikasi pengolah kata

seperti spelling check, thesaurus, hyphenation, autocorrect, find and replace,

mail merge, dll. Selain itu Writer mempunyai fitur untuk pengaturan

dokumen, diantaranya sebagai berikut.

Wizard, yang akan menuntun pengguna langkah demi langkah untuk
membuat dokumen atau menggunakan fitur di dalam Writer seperti
surat, fax, document converter, dll

Page-layout, untuk pengaturan tata letak dalam halaman dokumen.
Pengkaitan dengan objek lain melalui hyperlink

Konversi secara langsung ke tipe file portable document format (pdf).
Tool untuk menggambar objek.

Tool untuk membuat formula matematika.

Rekam jejak perubahan terhadap dokumen.

Menggunakan standar internasional untuk dokumen terbuka, sehingga
membuat dokumen Writer dapat dibuka menggunakan pengolah kata
lainnya.

Dapat membuat dan membuka aplikasi lain. Misalnya pengguna sedang
bekerja dengan Writer kemudian pengguna ingin membuat atau
membuka dokumen di Calc, pengguna dapat melakukan dengan

mengklik icon Open di Menu File. Pengguna juga dapat membuka



http://www.apache.org/licenses/LICENSE-2.0.html
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dokumen yang dibuat dengan menggunakan aplikasi Microsoft Office.

e Dapat menyimpan dokumen dalam tipe file yang banyak, dan masih
banyak lagi fitur lain yang tidak disebutkan dalam modul ini.

Dengan dukungan fitur-fitur tersebut di atas, Writer dapat digunakan untuk

membuat dokumen untuk administrasi umum, dokumen matematika dan

dokumen yang berisi gambar dan atau objek multimedia.

D. Aktivitas
Aktivitas 1 : Download dan Instalasi

Untuk menginstal OpenOffice, software installer dapat di-download dari

website resmi OpenOffice. Cara men-download installer sebagai berikut.

¢ Kunjungi website OpenOffice dengan alamat www.openoffice.org

e Pilih bagian pada linkl want to download Apache OpenOffice untuk

download softwareinstaller.

e | want to learn more about OpenOffice
What is Apache OpenOffice? And why should | use it?

1 | wantto download Apache OpenOffice
AV (Most recent release: 4.1.2)

Download Apache OpenOffice for free (really!) | Click here to get more information.

@ | need help with my OpenOffice

Help is at hand whenever you need it

E]{I'r) | want to do more with my OpenOffice

Extend Apache OpenOffice with additional functionality, templates and clipart.

| want to participate in OpenOffice

Apache OpenOffice is made with help from people all over the world. Feel free to contribute!

)

e Pilih bahasa, versi installer yang akan Anda gunakan serta pilih yang

sesuai dengan platform (sistem operasi) komputer kerja Anda.

Download Apache OpenOffice
(Hosted by Sourceforge_net - A trusted website)

Select your favorite operating guage and

| [ windows (exe) v || english [us] vl 412 vl

(Download full installation) (Download language pacla



http://www.openoffice.org/
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e Klik tombol Download full installation.
Setelah mendapatkan softwareinstaller-nya langkah selanjutnya adalah
menginstal OpenOffice pada komputer kerja. Kebutuhan sistem untuk

instalasi OpenOffice pada platform Windows sebagai berikut.

e Windows XP, Windows 2003, Windows 2012, Windows Vista, Windows
7, Windows 8, Windows 8.1, Windows 10.

e Memori 256 MB RAM (disarankan 512 MB RAM).

e Tersedia ruang pada hardisk paling sedikit 650 MB untuk instalasi

melalui download software.
e Resolusilayar 1024 x 768 piksel atau lebih tinggi.

Untuk proses instalasi klik dua kali softwareinstaller dan ikuti perintah

instalasi.

Aktivitas 2: Membuat Dokumen Writer

Dokumen Writer dapat berisi teks naskah, gambar, equation, atau gabungan
unsur-unsur tersebut. Untuk menggunakan Writer, langkah-langkahnya

sebagai berikut.

1. Klik OpenOffice Writer .

OpenOffice Draw NEW
OpenOffice Impress NEW

OpenOffice Math

OpenOffice Writer

Gambar berikut adalah antarmuka OpenOfice versi 4.1.2.
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File Edit View Insert Format Table Tools Window Help-f=—= Baris Menu

B-B2-d= 0 BEAR Y B¢ 0 @FH-» HOEETA @ gi[fv Vb 4|

Default Er‘hmeswewﬂoman Mz ] BT U E == it eEsE A2

-2

Toolbar Standar
Toolbar formating

2. Sebelum mengetikkan naskah sebaiknya dilakukan pengaturan lingkungan
kerja Writer. Pengaturan lingkungan kerja Writer dilakukan melalui menu
Tool>Option. Lakukan pengaturan pada menu-menu yang ada sesuai
kebutuhan Anda.

OpenOffice
Load/Save bl .
q OpenOffice Writer

OpenOffice Writed

This is where you specify various settings for text documents. These settings determine
how your text documents are handled in OpenOffice and are valid for all new
OpenOffice Writer documents. You can also define a few settings for the active text
document if you save it afterwards.

Formatting Aids

Grid

Basic Fonts (Western)
Print

Table

Changes
Compatibility
AutoCaption

Mail Merge E-mail
OpenOffice Writer/Web
OpenOffice Base
Charts

Internet

[ oK | concet || Help i Back |

Misalnya akan diatur satuan ukuran dalam centimeter, maka langkahnya
dengan memilih menu Tool->Option->General. Pada

Settings>Measurement unit dipilih Centimeter.
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OpenOffice

Load/Save Update

Language Settings Update links when loading Automatically
= ;

TEew (®) On request [+ Charts

Formatting Aids

Grid O Never
I?l;a.slc Fonts (Western) Setis
rint
Table I Measurement unit Centimeter
Changes

Compatibility Tab stops 1.25cm El

AutoCaption

Mail Merge E-mail
OpenOffice Writer/Web
OpenOffice Base
Charts
Internet

HEHEBBE

Untuk pengaturan-pengaturan lainnya dapat dilakukan dengan memilih

menu yang memuat item yang akan diatur.

3. Ketikkan naskah Anda, kemudian lakukan pengaturan halaman dengan
cara klik menu Format->Page.

| Organizer |Page |Background | Header |Footer | Borders |[Columns | Footnote |

Paper format

Width 21.59em |3
Height 7%4em [3]

Orientation (@) Portrait

Margins ———————————————————— Layout settings
rome
Top 400 em O Register-true
Bottom 200 em E Reference Style

[ ok | canced || Help || Resmt |

Pada pengaturan page/halaman dapat diatur margin, ukuran Kkertas,
orientasi kertas, background, header, footer, dll.
4. Untuk pengaturan paragraf dilakukan melalui menu

Format->Paragraph.
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Background
Indents & Spacing |Alignment Text Flow | QOutline & Numbering |Tabs | Drop Caps | Borders
Indent
I
Beoretet
I
After text I
Firstline —
[ Automatic EE——
Spacing ]
Above paragraph I
Behou posagragh oo [ |T—
Line spacing
Register-true
[] Activate
| ok || Cancel || Help || Reset |

Pada pengaturan paragraph dapat diatur jarak baris, perataan, penomoran,
dll. Untuk pengaturan halaman dan paragraf dapat dilakukan lebih cepat
melalui menu Properties yang terletak di sebelah kanan lembar kerja Writer

dengan terlebih dahuluklik ikon menu Properties (ditandai warna merah).

Properties

i

E Text

x
=]
|Tim5NewRoman E”'\Z E|
B 7 U-wme iy & & :'*

MR N- A-2- ®

=) Paragraph =}
--ic-  &0-

Spacing: Indent:

o=z & & v

L fooon [ Epmen E

= omen [2] 57 omen_[£]

= =omen [
= Page =
Orientation: Margin:

Al L]~
Size: Column;

O- E-
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Menyisipkan gambar

Writer juga menyediakan fitur sisip gambar. Untuk menyisipkan gambar

dapat dilakukan melalui menu Insert->Picture-> From File/Scan.

Insert | Fgrmat Table Tools Window Help

Manual Break... 3 IEI B

Fields ,
8  Special Character... pan E IE
Formatting Mark y :Z EETRRE
Section... banyaknya kal:
@ Hyperlink terthadap peran
Header » | saw perangkat
Foster * | Moodle Mood
Footnote/Endnote,..
T learning envire
2 Bookmark. culoup lengkap
§. Cross-reference... untuk dijalank:
=] Comment Ctri+A+C | ada koneksi int
Script...

uga bisa digur

personal web s

Indeges and Tables  »

Envelope...

Anda yang me
Frame... [
internet dan de
EH  Table.. Ctrl+F12
Horizontal Ruler...
I Picture » ﬂ Erom File... I
“E. Moyie and Sound Scan v
Object
[ Floating Frame
] EFile..

Pilih gambar dari file atau hasil scan. Setelah gambar berhasil disisipkan

secara otomatis akan muncul menu Properties untuk pengaturan gambar.

Properties X =
El Graphic

Erightness: Contrast:
0% =] o EIE 3

Color mode: Transparency:

Default v]lo% E ©
wox E®or [ &
Plox  Ellhw [

El Position and Size &
Width: Height:

[11.37 em ] [270em H
O Keep ratio

E Wrap &
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Hasil sisip gambar sebagai berikut:

Tools Window Help

Q| % B-¢D-¢-@E-»

ew Roman v[jz [»| BSIf U = %% iZiZes4E A-W-@ -
Y Ty 2

POODLE

Dewasa ini elearning semakin banyak

Poo d I e digupaken dan dibutubkan. Seiring

A Portable Moodle Solation 52838 banyaknya kalasgan yang ingin
mengimplementasikan e-learning, maka

kebutuhan terhadap perangkat lunak untuk membangun sistem e-learning semakin
besar. Salah satn perangkat lunak yang dapat digunakan untuk membangun e-learning

Menyisipkan hyperlink

Dokumen Writer juga dapat memuat kata/kalimat yang ditautkan dengan
dokumen lain. Untuk pentautan dokumen dapat dilakukan melalui menu
hyperlink. Misalnya di dalam dokumen Writer tersebut akan ditautkan

dengan alamat suatu website. Langkah-langkahnya sebegai berikut.

1. Blok kata/kalimat/objek yang akan disisipi link atau ditautkan dengan

dokumen lain kemudian klik menu Insert->Hyperlink.

Section... v o mengimplementasikan elearning. maka

m kebutuhan terhadap perangkat lunak untuk membangun sistem e-learning semakin

G

Header
Footer
Footnote/Endnote...
Caption...
Bookmark...

Cross-reference...

it £l %

Comment Cirl+Alt+C
Script...

Indexes and Tables
Enyelope...

[=] Frame..

EH Iable. Ctrl+F12

Horizontal Ruler...

v

v

v

besar. Salah satu perangkat lunak vang dapat digunakan natuk membangun e-learning
adalah Moodle, Moodle merupakan learning management system (LMS) atau virtual

learning esvivonment (VLE) vang bersifat open sowce dan memiliki fitur-fitur vang

cukup lengkap untuk penyelenggaraan kelas virtual . Pada dasarnya Moodle didesain

untuk dijalankan dengan terkoneksi internet, sehingga bagi sebagian orang yang tidak
ada koneksi internet agak kesulitan untuk menggunakan Moodle. Sebenarnya Moodle

juga bisa digunakan secara offline. dengan banftian perangkat lunak semacam

Anda yang menginginkan fetap bisa menjalankan Moodle tanpa adanya koneksi
interaet dan dengan cara yang tidak rumit. Poodle merupakan jawabanaya,

2. Pilih tipe hyperlink kemudian masukkan alamat dokumen atau alamat
suatu website. Ada empat kategori dokumen yang bisa ditautkan yaitu

Internet (alamat website, FTP, Telnet), Mail & News (email, berita),
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document (dokumen dalam berbagai tipe file) dan New Document
(dokumen baru) baik dokumen Writer sendiri maupun dokumen yang

berbasis aplikasi lain.

% Hyperlink type -
= () Web (I ETP () Telnet
Internet
= I Target |httpslh’dDc;.moodle.orgﬂQfen/\n;ta\\atlon_gmde_—_MﬂodIEH
A =
°
Mail & News

Further settings

fE
=] Text

Document

MNew Document

[<]
L U®

=
&
3
a

Help | | Back |

| Apply | ‘ Close

Misalnya pada contoh di atas akan ditautkan alamat suatu website, maka
terlebih dahulu dipilih opsi web kemudian pada bagian Target diketikkan
(dapat juga dengan cara Copy - Paste) alamat website tersebut.

Hasil pentautan adalah kata yang mengandung alamat suatu website, jika
kursor didekatkan pada kata tersebut maka akan muncul ikon tangan dan

tooltip alamat web yang ditautkan.

Anda vang menginginkan fefap bisa menjalankan Moodle fanpa adanya koneksi
internet dan dengan cara yang tidak rumit. Poodle merupakan jawabannya,
Untuk mendapatkan software Poodle. silahkan kunjungi website Moodle.

|Ctr|-c||ck to open hyperlink: https://docs.moodle,

Menggambar objek

Writer juga mempunyai kemampuan menggambar objek-objek. Fasilitas

gambar dapat diaktifkan melalui ikon Show Draw Functionpada toolbar

formatting.

- esl]nes




Modul Diklat Guru Pembelajar

Jika ikon tersebut aktif maka di bagian bahwa lembar kerja Writer akan
muncul toolbar untuk menggambar (draw toolbar). Gambar berikut

memberikan ilustrasi isi dari draw toolbar.

i /  EH@Z2 TS & -@ -« -F - & & m‘

Untuk menggunakan tool tersebut klik pada tool kemudian drag mouse pada
kertas kerja Writer. Perhatikan gambar pada bagian yang ditandai warna
merah. Tombol tersebut berfungsi untuk pengaturan toolbar. Misalnya Anda
ingin mengatur tool apa saja yang akan dimunculkan pada toolbar. Melalui
tombol dropdown menutersebut dapat diatur perintah yang ditampilkan,

seperti ditunjukkan gambar berikut.

|Menu;|Keyboard |Ioolbars |Events |

OpenOffice Writer Toolbars
Toolbar

Toclbar Content
Commands [% - Add...

/ Line Madify |
[ Rectangle

@ Ellipse

[] §% Polygon

O .f‘ Curve

+Z, Freeform Line

o Arc

O & Ellipse Pie “

< >

[« =]

Save In |0pen0ffice Writer |

Description

Allows you to select objects in the current docurnent.

Misalnya akan digambar sebuah segitiga siku-siku. Langkah-langkahnya

sebagai berikut.

e Aktifkan ikon Show Draw Function
e Klik tool Basic shapes>Right Triangle (tool untuk menggambar

segitiga siku-siku).
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EENe0e
Elalh]lw & @
@@ OFOa
& WO

L RS @ -« -9

e Drag tool tersebut pada lembar kerja Writer. Hasilnya adalah sebuah

segitiga siku-siku

e Beri nama pada titik-titik sudut. Untuk memberi nama titik sudut

digunakan tool Text@. Hasilnya sebagai berikut:

B

e Kilik objek yang baru saja digambar, perhatikan propertis gambar bagian
kanan lembar kerja. Fill segitiga dapat diatur melalui Properties

Area->Fill. Misal akan diganti dengan arsiran, maka dipilih Fill objek
Hatching.

El Area E
Fill:

|Hatching

Transparency:

|None |'I]'}E| E“

14
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Hasil dari pengaturan Fill sebagai berikut:

-

Menyisipkan tabel

Dalam membuat naskah dokumen, kadang Anda membutuhkan bekerja
dengan tabel . Pada dokumen Writer juga dapat disisipkan tabel. Untuk

menyisipkan tabel langkahnya sebagai berikut.

e Klik menu Insert-> Tableatau menu Table atau klik ikon &=,

e Atur judul, kolom, baris tabel dan pengaturan tambahan lainnya. Pada
gambar berikut ditunjukkan bahwa Anda juga dapat mengatur heading,
border, split tabel. Pada pengaturan tersebut akan dihasilkan tabel
dengan kolom 3 baris 5, heading berulang, mempunyai border dan tabel

tidak ada split.

Mame |P‘enggunapoodlal

Size

Columns

Options
Heading

Repeat heading
The first FoWS
Don't split table
Border

| AutcFormat... ‘




Kegiatan Pembelajaran 1

Writer juga menyediakan format tabel bawaan Writer. Klik tombol
AutoFormat untuk memilih format tabel Anda. Perhatikan gambar berikut,
autoformat tabel Writer juga menyediakan pilihan autoformat untuk

penomoran, font, border, pattern, dan alignment.

‘

Format

Mone
Default
£
Blue
Brown
Yellow
Gray
Green
Red
Black 1

Diacl 2

North

South

Sum

K

Cancel

Help

Delete

= s
H o =
»

Formatting
MNumber format

Borders

Fant
Pattern

Alignment

e Setelah kerangka tabel muncul di kertas kerja Writer, akan muncul juga
jendela pemformatan tabel yang menyediakan pengaturan posisi isi tabel,

hapus tambah baris/kolom, pengaturan ketebalan dan warna border, dll.

v X
O-&-=m=-
== S EE Z

Menyisipkan fungsi/formula di dalam tabel

Baris/kolom tabel pada Writer mempunyai perilaku seperti halnya cell pada
pengolah angka, sehingga di dalam baris/kolom dapat disisipkan fungsi atau

formula. Cara menyisipkan fungsi/formula sebagai berikut.

e Pilih cell tertentu.

e Pada menu Tablepilih Formula.
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Table | Tools Window Help

Insert »
Delete »
Select »
Merge Cells

Split Cells

Protect Cells

Merge Table

Split Table

4, | AutoFormat...
Autofit 9
Heading rows repeat
Convert v

Sort...
Farmula I F2

MNumber Format...

Table Boundaries

Table Properties...

e Pilih formula atau fungsi, misal dipilih Sum, kemudian pilih cell yang

akan dihitung dengan fungsi Sum tersebut.

ﬁ -~ %8 < | =sum <TabelPenggunaPoodle.C2:( 8=

e Tekan tombol Enter maka pada cell akan dihasilkan jumlah dari isi cell C2

sampai C8.

Menyisipkan formula matematika

Writer juga mempunyai kemampuan membuat formula matematika.
Sebenarnya ada fitur OpenOffice yang khusus untuk pembuatan formula
matematika, yaitu OpenOffice Math. Namun Math juga terintegrasi di dalam
Writer. Baik pada Writer maupun Math, fitur pembuatan formula matematika

mempunyai fungsi dan cara penggunaan yang sama.

Untuk mengaktifkan formula dilakukan melalui menu

Insert-> Object->Formula.
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Insert | Format Tgble Tools Window Help

Manual Break... @ B -

Fields

,
88 Special Character... e [v] [12 |

FormattingMark  » [00- 1+ 2- 13
Section... <
@ typetink learning environn

Header eulenp lengkap un

2 v

Footer » | pamk dijalagkan ¢

Footnote/Endnote.. ada konsksi intert

Caption.. o b

juga bisa na
#®  Bookmark. e ceuns
S Cross-reference personal web ser
%] Comment Cl+Al-C | Anda vang meng

Seript. internet dan deng:

Indeges and Tables 1 | 1ype oy en dapant

Envelope...

] Frame..
EH Table.. Ctrl+F12

Horizontal Ruler.

Picture
5 Moyie and Sound
| objee »| [ OLE Object...
5] Floating Frame 45 Plug-in..

& He. @ Formula
- EEE— b Chert..

Perhatikan area kerja formula berikut.

File Edit View Format Tools Window ﬂe\pMeﬂu
B-rEB-H= B & i | - @ -
E‘ 21

| - [ 1. 2 . 3

1 iTeks
Elements n

: usb acst fx) 2a

a8 & (8 A FElements

2

a4 -0 x4 To -
a+b a-b axb axb arb
7 a-b % azb a/b avb

ash

Formula editor

Pada baris menu terdapat menu-menu untuk pengaturan tampilan, format
formula yang dibuat. Untuk menampilkan atau menyembunyikan jendela
Elements yang Dberisi simbol-simbol matematika melalui menu
View>Elements. Untuk membuat formula dipilih simbol-simbol
matematika dari jendela Elements. Pengetikan formula pada jendela editor

dan hasilnya akan tampak pada bagian teks.
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Untuk pemformatan formula dilakukan melalui menu Format.

[Fermat | Tools !

Fonts...

Font Size...

Spacing...
Alignment...

Text Mode

Misalnya akan dibuat formula berikut:

Tentukan [ x?vVx3 + 7 dx
Ada beberapa simbol yang harus diketikkan yaitu f , X2, v ,x3, +7.
Langkah-langkahnya sebagai berikut.

¢ Insert >Formula - Object
e Pilih simbol integral dari kelompok operator, langkahnya ditunjukkan

urutan nomor pada gambar berikut.

ey

- Lij[f=
o~ Elements u

A % asb aed [ '
N O 72

nx Ex Tx Ux :Z
A
o e fx ffe %

e Klik simbol <?>, klik function dilanjutkan klik power kemudian isi
bilangan pokok dan pangkatnya dengan isian x"{2}, urutannya dapat

diperhatikan pada gambar berikut.
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(IS

o~ Elements n

7 ash ash zﬂ

AN %
- -2
. I e lug@

sin s ton ot W%

sin' cos' o tan! cof? WX

sinh  cosh  tonh  coth x|

-
I——

<
lm{m] 3

e Langkah selanjutnya adalah mengetikkan simbol akar kuadrat. Pilih

simbol tersebut dari kelompok Function dan pilih Square root, kemudian

dilanjutkan memilih bentuk pangkat untuk mengetikkan x3.

D ¥V

i Elements

1!
: % asb asA >a
d & @&

a
- e In exp log @
ljn sin  cos  tan  cot @2

sin! as! ten! ef! WX

sinh cosh  tanh  coth  |x

-
[

<

|i:m: x*{2}sqrt{s’*{<?>} ]4

[silah <?> pada editor formula dengan isian {x"{3}}, sehingga

perintahnya menjadi int x*{2} sqrt{x*{3}} dan hasilnya sebagai berikut:

20
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e Langkah terakhir adalah mengetikkan +7 dengan cara memilih tanda +

dari kelompok Unary/Binary Operators.

- 1 Elements
A ||a ash Iy Zg
a o ) &

=
—70 ta Fa -a

Y a+b a-b axb axb anb

Eg a-b % azb a/b avb
- asb

IL\_

<

int x"{2lsgze(=" (310 | 3

Pada langkah ketiga gambar diketikkan angka 7.

e Setelah semua formula diketikkan, tekan tombol Escape untuk keluar

dari editor formula. Hasil pembuatan formula sebagai berikut:

Tentukan | [ x°Vax’+7dx

Menyimpan file
Untuk menyimpan dokumen Writer dengan langkah-langkah berikut.

¢ Klik File->Save as

o Tentukan lokasi penyimpanan file dan beri nama serta tipe file. Pada
gambar berikut ditunjukkan bahwa dokumen Writer dapat disimpan
dalam berbagai tipe file, bahkan bisa juga disimpan ke format tipe file
aplikasi lain, misalnya Microsoft Word. Untuk menyimpan file dalam

format dokumen OpenOffice, pilih tipe file ODF Text document.

21
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T 0 e DATAT(D:) » 2015 » modulepukg v
Organize = Mew folder
i Desktop A Name B
7| Documents .
& Downloads - sesgnment
. Bakal fix
W‘h mudanurul@out .
I Music . blocks
J blo
= Pictures . h i
| cha
B Videos . cs
&y WinTsys (C:) -
DATAT (DY) . dragmath
= 3
| EQU
—a DATAZ (E) o
L 4

File name: | Cara membuat dokumen Writer

Save as type: | ODF Text Document (odt)

QDF Text Document (.odt)

ODF Text Document Template (.ott)
OpenOffice.org XML 1.0 Text Document (.sxw)
OpenOffice.org XML 1.0 Text Document Template (.stw)
Microsoft Word 97/2000/XP (.doc)

Microsoft Word 95 (.doc)

Microsoft Word 8.0 (.doc)

Rich Text Format [.rtf)

Text (bet)

Text Encoded (bet)

‘* Hide Folders HTML Docurnent (OpenOffice Writer) (html)
Microsoft Word 2003 XML (xml)

r Uniform Office Format 2 Text (uot)

Mengekspor ke dokumen pdf

Salah satu keunggulan Writer adalah kemampuannya mengekspor
dokumennya ke dokumen pdf tanpa adanya tambahan utility apapun. Untuk

mengekspor ke dokumen pdf langkahnya sebagai berikut.

e Klik menu File>Export pdf atau dengan mengeklik ikon = pada
standar toolbar.
e Langkah selanjutnya adalah pengaturan untuk output dokumen pdf,

termasuk pengaturan keamanan (password) untuk dokumen pdf.
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General |Ini‘tia|‘u’iew User Interface |Links|Securi‘ty|

Range General
@ i []PDF/A-1a
() Pages I:I [[]Tagged PDF
() Selection Create PDF form
Images Submit format FDF |z|
(O Lossless compression [] Allow duplicate field names
(®) JPEG compression Export bookmarks
Quality 90 % EI [[] Export comments
[ Reduce image resolution [] Export autornatically inserted blank pages

[] Embed standard fonts
[] Embed this decument inside the PDF

|| Export |I| Cancel || Help |

Klik tombol Export untuk mengkonversi ke dokumen pdf, kemudian beri
nama file dan klik tombol Save untuk menyimpan file pdf yang

dihasilkan.

. Latihan/tugas

. OpenOffice merupakan software yang bersifat ....

a. Freeware ¢. Open source

b. Shareware d. Berbayar
Berikut ini yang tidak termasuk layanan OpenOffice adalah ....
a. Writer ¢. Draw

b. Impress d. Acces

. OpenOffice mempunyai fitur untuk pengolah kata. Layanan tersebut

adalah....
a. Writer ¢. Draw
b. Impress d. Acces

Pernyataan berikut ini adalah beberapa kelebihan dari OpenOffice
dibanding beberapa pengolah kata lainnya, kecuali ....
a. Multiplatform

b. Konsistensi antarmuka

23
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c. Banyak paket bahasa
d. Adanya formula matematika
5. Fitur Writer yang akan menuntun langkah demi langkah membuat suatu
dokumen adalah ....
a. Template c¢. Wizard
b. Anchor d. Hyperlink
6. Perintah untuk mengubah satuan ukuran dalam Writer adalah ....
a. Tool 20ption >0penOffice Writer 2General
b. Tool 20ption >0penOffice Writer 2View
c. Tool 20ption 20penOffice Writer 2Formating Aids
d. Tool 20ption 20penOffice Writer 2Grid

7. Perintah untuk mentautkan dokumen Writer dengan dokumen lain adalah

a. Template c. Wizard
b. Anchor d. Hyperlink
8. Tipe file untuk standar dokumen teks OpenOffice adalah ....
a. odt c. doc
b. ott d. stw

F. Rangkuman

OpenOffice merupakan software open source untuk pengolah Kkata.
OpenOffice mempunyai beberapa layanan yaitu Writer, Impress, Calc, Draw,
Base. OpenOffice mempunyai beberapa kelebihan dibanding aplikasi
perkantoran dengan lainnya, diantaranya adalah OpenOffice bebas
digunakan untuk kepentingan apapun secara gratis. Kelebihan lainnya ada

pada fitur OpenOffice.

Layanan OpenOffice untuk pengolah kata adalah Writer. Writer mempunyai
kemampuan untuk membuat dokumen yang berisi teks, gambar, formula,

multimedia, fungsi atau gabungan semuanya. Ada beberapa kelebihan Writer
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dibanding pengolah kata lainnya, yaitu kemampuan konversi ke dokumen
pdf tanpa adanya tambahan utility apapun. OpenOffice mempunyai tipe file

standar dokumen terbuka.
G. Umpan Balik dan Tindak Lanjut

Setelah Anda mempelajari materi dan mempraktekkan aktivitas
pembelajaran silahkan mencoba menjawab latihan. Cocokkkan Jawaban
Anda pada kunci jawaban. Jika Anda masih kesulitan dalam mengerjakan
aktivitas pembelajaran Anda bisa membaca kembali uraian materi di
kegiatan pembelajaran ini. Jika Anda dapat menjawab pertanyaan dengan
betul pada latihan tersebut berarti Anda sudah menguasai materi yang ada di
modul ini dan dapat melanjutkan mempelajari modul berikutnya. Jika semua
doal belum terselesaikan, ulangi kembali untuk dapat memahami materi

yang disampaikan.

H.Kunci Jawaban

c
d

o8]

® N o ok W N
(@]
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Mengenal Impress Dan Calc

A. Tujuan

Tujuan kegiatan pembelajaran ini adalah Peserta dapat menggunakan

Impress dan Calc untuk kepentingan pengembangan diri dan profesinya.
B. Indikator Pencapaian Kompetensi
Setelah menyelesaikan pembelajaran ini peserta dapat:

e membuat slide presentasi dengan Impress yang di dalam slide tersebut ada
gambar, formula, sound, animasi, grafik, dll.

e membuat tabel, grafik, menggunakan rumus dengan Calc.
C. Uraian Materi

Dalam pembelajaran seringkali guru membutuhkan alat bantu media
berbasis Teknologi Informasi dan Komunikasi (TIK). Media TIK selain
membantu guru menyampaikan materi, juga berfungsi untuk memberikan
visualisasi materi dan membuat suasana belajar yang lebih menarik. Oleh
karena itu guru hendaknya mampu dan menguasai TIK dengan baik, sehingga

guru dapat memanfaatkannya untuk pembelajaran.

Media pembelajaran TIK dapat dibuat menggunakan berbagai
softwaretermasuk softwareperkantoran. Dalam keseharian software
perkantoran banyak digunakan untuk administrasi umum. Namun

sebenarnya banyak fitur-fitur yang bisa dimanfaatkan untuk pembelajaran.

Sebagian besar masyarakat,termasuk guru, menggunakan software
perkantoran yang berbayar sehingga harus mengeluarkan sejumlah uang
untuk membayar lisensi. Hal ini bisa menjadi kendala bagi orang atau

instansi yang tidak memiliki dana. Sebagian dari mereka yang tidak memiliki
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dana memilih untuk tidak melakukan aktivitas pemanfaatan software
perkantoran, dan sebagian lagi tetap menggunakan software tersebut secara
ilegal alias membajak. Permasalahan ini harus diatasi. Masyarakat perlu
dikenalkan software perkantoran yang gratis dan legal. Salah satu software
perkantoran yang gratis dan legal adalah OpenOffice. Software perkantoran
OpenOffice merupakan software open source, di mana software tersebut
bebas dan gratis digunakan oleh siapapun untuk kepentingan apapun. Oleh
karena itu guru perlu dikenalkan supaya bisa mengetahui dan menguasai
OpenOffice kemudian memanfaatkan untuk pembelajaran. OpenOffice
mempunyai layanan untuk membuat presentasi yaitu Impress dan pengolah

angka, yaitu Calc.
Impress

Anda mengenal PowerPoint? Kalau Anda sudah mengenal atau bahkan sudah
pernah menggunakan PowerPoint tentu Anda tidak akan asing dengan
OpenOffice Impress. Impress merupakan software yang digunakan untuk
membuat presentasi multimedia. Di dalam slide Impress bisa digabungkan
teks, gambar, suara, video, animasi dan objek-objek lain atau gabungan dari
berbagai objek tersebut. Sebagai software pembuat presentasi, Impress

mempunyai fitur unggulan sebagai berikut.

e Impress mempunyai fitur animasi yang banyak.

e Dokumen Impress dapat diekspor ke dokumen flash atau pdf secara
langsung tanpa adanya software tambahan.

e Dokumen Impress dapat disimpan ke tipe file PowerPoint dan bisa
dibuka menggunakan PowerPoint.

e Impress memiliki perangkat penggambar dan diagram yang mudah untuk
digunakan.

Calc

Calc merupakan fitur pengolah angka OpenOffice. Calc dapat digunakan

untuk membuat grafik, tabel, mengolah data dengan fungsi-fungsi
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matematika, logika dan fungsi-fungsi lainnya. Calc juga mempunyai

perangkat penggambar. Bahkan Calc pun bisa berfungsi sebagai pengolah

kata.

Apa yang menarik dari Calc?

Calc mempunyai fitur-fitur yang menjadikan software tersebut cukup

powerfull, diantaranya sebagai berikut.

Chart, fitur ini untuk membuat grafik dua dan tiga dimensi.

Mempunyai fungsi-fungsi untuk pengolahan dan analisis data, meliputi
fungsi matematika, logika, statistika, database, teks, array, keuangan dan
waktu.

Perangkat penggambar yang dengan mudah dapat digunakan untuk
membuat objek.

Dengan fitur conditional formatting,Calc dapat digunakan untuk
membuat permainan.

Mempunyai fitur menyisipkan objek, formula, sound, video dan file
lainnya.

Dokumen Calc dapat diekspor secara langsung ke dokumen pdf.

D. Aktivitas

Aktivitas 1 : Mengelola Slide presentasi

Untuk mulai menggunakan Impress, klik OpenOffice Impress.

;i OpenOfiice Draw NEW

[ OpenOffice Impress NEW

? OpenOfiice Math

e

OpenOffice Writer
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Wizard presentasi akan menuntun Anda untuk memilih aktivitas yang akan
Anda lakukan, apakah membuat presentasi kosong, mengambil dari
template, atau membuka file yang sudah ada. Pilih membuat presentasi

kosong (Empty presentation).

Type
(®) Empty presentation

() Erom template

() Open existing presentation

Preview

Do not show this wizard again

| Help | canca | c<Back [ News> || ceate |

Kemudian klik Nextuntuk pengaturan slide design dan media output.

m

Select a slide design
|Presentatlon Backgrounds
<QOriginal> A
Black and White
Blue Border
¥

Blue Lmas and Gradients

S g aptip e
() Original (®) Sereen

() Overhead sheet () Slide
(2 Paper

Preview

‘ Help ‘ | Cancel ‘ | << Back | ‘ ﬂmct)) ‘ | Create

Klik Next untuk melanjutkan, mengatur slide transition dan tipe presentasi

dan kemudian klik tombol Create.
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Select a slide transition

Select the presentationtype ———————
(®) Default
() Autematic

Duration of page

Duration of pause

Show lego

‘ Help | | Cancel | | << Back | Nesxt > >

Pada dasarnya untuk membuat slide bisa dengan cara langsung klik tombol

Create pada langkah 1 dan untuk pengaturan lainnya dilakukan menyusul.

Slide transition

Untuk menarik perhatian audiens pada saat presentasi, diberikan efek pada
kemunculan slide atau pergantian antar slide, yang disebut dengan slide

transition. Pengaturan slide transition dapat dilakukan dengan cara berikut.:

o Pilih slide yang akan diatur transisinya.

o Tampilkan menu pengaturan slide dengan cara klik kanan slide kemudian

pilih slide transition, atau dengan cara klik ikon slide transition pada

sisi kanan jendela Impress.

=

o Lakukan pengaturan pada menu Slide Transition.
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Slide Transition x5

Apply to selected siides

Mo Transition ~

Wheel Clockwise, 1 Spoke
Wheel Clockwise, 2 Spokes ESS
Wheel Clockwise, 3 Spokes

Wheel Clockwise, 4 Spokes ﬁ
Wheel Clockwise, 8 Spokes

U Right e
ncover Rigl v &

Modify transition ———————————

Loop until next sound

<] [=]

Advance siide
() On mouse click

@® Automatically after

Apply to All Slides
Shide Show

Automatic preview

Pengaturan yang dilakukan meliputi slide transition, modify slide

(kecepatan transisi, suara yang menyertai keluarnya slide ) dan advanced

slide.

Slide design

Jika pada wizard presentasi Anda belum mengatur desain slide atau ingin
mengganti desain yang digunakan, maka desain slide presentasi dapat diatur
melalui Format->Slide Design. Atau bisa juga dengan cara klik kanan slide
kemudian memilih slide design.

Select a slide design
oK

A
Cancel

Help

Default

[[] Exchange background page

[7] Delete unused backgrounds

Klik tombol Loaduntuk memilih desain yang akan digunakan. Ada beberapa
pilihan slide design. Anda bisa menggunakan template yang disediakan

Impress, selain itu Anda juga bisa menggunakan desain template milik Anda
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sendiri karena Impress memberikan kesempatan bagi pengguna untuk

memasang desainnya sendiri.

Gambar berikut merupakan jendela utama Impress. Perhatikan bagian-

bagian dari jendela tersebut.

File Edit View |nsert Format Tools Slide Show Window Help Baris menu

B-E-U= 2 BESE Ry 9-¢-12E-0H @R O .E@-A- i

b = - [——v] oo 5] B Gmysv] & el | Toolbar presentasi
Shides X

|Normat [Outiine | Notes |Handout | Siide Sorter |

Toolbar standar

slide ' Click to add title  udu siide

Isi slide

Click to add text

Drawing bar

/o ESTIE % ¢ @ @ - P-&- s ORE @N-3- 5 0

Mengatur layout slide

Sebelum lebih lanjut membuat presentasi, sebaiknya atur Layout slide
terlebih dahulu. Anda dapat mengganti layout lama dengan layout baru yang
sesuai. Layout slide dapat diatur melalui menu Format->slide layout

kemudian atur pada properties Layout.

L =]
| =

= ==

|I:II:I |I:I
 — — o o
|I:II:I |I:II:II:I
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Pengaturan layout slide juga bisa dilakukan dencan cara klik kanan slide

kemudian pilih layout slide.
Memulai membuat slide presentasi

Untuk mulai membuat slide, ketikkan judul pada bagian Click add to title.
Ketikkan isi slide di bagian Click to add text. Pengaturan paragraf, jarak baris,
jenis font, dan lain-lain pada slide dapat dilakukan melalui menu Format

atau menu Properties teks pada bagian kanan jendela Impress.

Properties x
5 Text =
|rial [v] 4 [v]
B/ U-w=m [KIs
Bm Y- A
El Paragraph &
=E==

S oTiT v

Spacing: Indent:

o= o= LS

o= o=

&looor  [fmglooor [5]
=pow Elzpo
= oo [

T

1= -

Menyisipkan gambar

Pada slide Impress dapat disisipkan gambar, foto. Cara menyisipkannya

sebagai berikut:

e Klik Insert>Picture>From File kemudian pilih gambar dan klik Open,

hasilnya seperti gambar berikut.

indout | Slide Sorter |

20 40 60 8 10 120 140 160 1so\z+o 20 240 260 2
Luas Segitiga

Perhatikan gambar berikut, berbentuk apakah martabak tersebut?

a o
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e Jika posisi kurang sesuai, atur posisi gambar melalui menu pada

Properties.

&l Position and Size &

Horizontal: Vertical:

2035mm 2] [764mm 2]

Width: Height:
|99.99 mm E“ |9999 mm E“
O Keep ratic

Rotation:

0.00 degrees
@ Elip: < s

Menambabh slide

Untuk menambah slide, cukup klik kanan slide kemudian pilih New Slide.

m—

y [teo a0
I New Slidel

S gt R bt Rename Slide

Slide Design
Slide Layout

Slide Transition

[E Hide Slide

Copy

Penambahan slide juga bisa dilakukan dengan cara menduplikasi slide. Klik
salah satu slide, dekatkan kursor maka akan muncul tombol untuk

menduplikasi slide.

Menggambar di Impress

34
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Untuk menggambar di impress dapat digunakan tool pada drawing bar.
Misalnya menggambar segitiga yang kemudian akan dicari luas dari segitiga,

langkahnya sebagai berikut.

¢ Klik Basic shapes->Isosceles triangle, kemudian drag di slide.

Luas Segitiga
o ’,q\ o
o la]

e Pengaturan area segitiga melalui menu propertis area (bagian kanan

jendela Impress).

L=l Area ]
Eill:

-
Transparency:

o

El Line &
Width: Color:

v L — -

Style: Transparency:
o

Arrow:

none - v| ‘- nene - v|

Corner style Cap style
|Rounded W | ‘Flat v |

Position and Size =

e Tambahkan garis tinggi dan garis sinar dua arah pada bagian alasnya.

| 7
i kemudian drag di

slide. Untuk garis sinar dua arah digambar dengan tool line kemudian

Untuk menggambar garis, klik tool line

dilakukan pengaturan pada ujung-ujungnya dengan memilih arrow pada
ujung kanan dan kirigaris, tebal dan style garis. Pengaturan gambar ada
pada menu properties. Setelah diatur maka akan dihasilkan garis dengan

sinar garis pada ujung-ujungnya.
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Luas Segitiga
>eories [CEr—— | —
Transparency:
E Line =
wl:th‘ Color:
/ - g —

I Style: Transparency:
Arrow:

Corner style Cap style

e Tambahkan huruf “a” di bawah garis dua sinar. Untuk menambahkan

teks digunakan tool TextLl .

e Tambahkan garis tinggi putus-putus. Untuk menggambar garis putus-
putus dengan cara menggambar garis dengan tool linekemudian style

garis dipilih Fine Dashed.

Style: Transparency:

== DL 5

- none -

Continuous
T

— — — WELENEREL
-------------- Ultrafine 2 Dots 3 Dashes
-------- Fine Dotted
- Line with Fine Dots
== Fine Dashed (var)
3 Dashes 3 Dots (var)

e Hasilnya adalah gambar segitiga dengan alas dan tinggi.

Luas Segitiga
A\
// I \\
AN
AR
/” | \
/ N
£ [ A\
Y | \
/ | \

a

Menyisipkan formula

Seringkali dalam slide presentasi menggunakan formula matematika. Pada
dasarnya penyisipan formula di Impress sama dengan penyisipan formula di
Writer, di mana formula diketikkan di formula editordengan mengambil

simbol-simbol di Elements.
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Penyisipan formula di Impress melalui menu Insert->Object->Formula.
Setelah editor formula aktif ketikkan formula. Misalnya akan diketikkan

formula berikut :

1
Luas segitiga = Etinggi X alas

Berikut pengetikkan formula di Impress:

Elements [ = |
P e ash ) Za

T & Bk

3

T +0 -4 4 ¥4 -4

| a-ba*b anb
: a-b azb a/b avb

> aob
i

Luas Segitiga = {1} over {2} tinggi times alas

Eeliling Segitiga = sisi + sisi + sisi

Untuk menghasilkan formula seperti yang dimaksud digunakan simbol

penjumlahan dua suku, perkalian dua suku, pecahan di Elements.
Menganimasikan Objek

Suatu saat Anda membutuhkan gerakan-gerakan objek dalam slide untuk
menekankan suatu maksud atau memberikan visualisasi. Impress
memfasilitasi untuk menggerakan objek dengan animasi. Objek meliputi
gambar, teks, formula, tabel, grafik, dll. Langkah-langkah menganimasikan

objek sebagai berikut.

e Pilih (klik atau blok) objek yang akan dianimasikan.
e Pilih menu Slideshow->Custom animation. Atur animasi yang
diinginkan pada menu Custom animation.

e Tambahkan animasi dengan cara klik tombol Add.
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Custom Animation =
Modify cffect

Change...

Bemove

Effect
Start

Property

Speed

First select the slide element and
then click 'Add..." to add an
animation effect.

Change order: f ’

e Pilih jenis animasi dan atur kecepatannya.
Ada beberapa jenis animasi dalam Impress, yaitu:

a. Entrance, untuk animasi dengan arah masuk.

b. Exit, untuk animasi dengan arah keluar.

c. Emphasis, untuk animasi yang memberikan tekanan, misalnya dengan
berputar-putar, kedip-kedip, efek zoom, dll.

d. Motion path, yaitu animasi yang mengikuti path atau alur tertentu.
Masing kelompok atau jenis masih mempunyai variasi animasi yang

cukup banyak. Gambar berikut menunjukkan pemilihan animasi jenis

Entrance->Box.

Entrance |Emphasis|Exi‘t |Mot\on Paths | Misc Effects |
Appear ~
Checkerboard
Circle
Diagonal Squares
Diamend
Dissolve In
Flash Once
Fly In
Fly in Slow
Peek In
Plus
Random Bars
Random Effects
Split
Venetian Blinds
Wedge
Wheel
Wipe ™

Speed ‘E E
Automatic preview

e Pada menu pengaturan animasi bagian Modify effect disediakan untuk

menambah, mengganti dan menghapus jenis animasi.
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Pada bagian Effect Boxada pengaturan mulainya animasi, kecepatan,

arah, urutan jalannya animasi.

Modify effect
| Add.. || Change..

Effect Box

Start

[on dlick
Direction

[in ][]
Speed

|Fa;t Izl

Change order: f ;

| Play || Slide Show |

Menyisipkan multimedia

Dalam slide presentasi seringkali digunakan narasi atau video. Untuk
menyisipkan narasi atau video ke dalam slide Impress dengan cara sebagai

berikut.

e Klik menu Insert->Movie and soundkemudian pilih file yang akan
disisipkan.
e Misal disisipkan sound. Maka setelah dipilih file, pada slide muncul ikon

sound dan kontrol untuk menambahkan sound lain, mengatur volume

Thon sma—>

dan menjalankan sound.

s segrga

0160150140190 1201101

001901801

B

Kentrol sourk

oz

£}
[

|i BlEEE
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Menyisipkan Grafik

Di dalam slide Impress juga dapat disisipkan grafik, dengan cara sebagai

berikut.

|ifhs

e Klik menu Insert->Chart atau ikon atau pada slide baru, klik ikon

Chart (ditunjukkan gambar berikut).

» Click to add text

i)

Insert Chart

L&
i

e Pilih jenis chart dengan cara klik ikon . Gambar berikut adalah tipe-
tipe chart.

E Bar
B pie
% Area
“ Line Normal

@ Net Shape
E:E Stock
Iﬂ Column and Line C)rlinder_
Cone
Pyramid
| OK | | Cancel | | Help |

e Misalnya dipilih tipe Pie dan klik OK. Pada slide Impress akan muncul

chart dengan tipe Pie.
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Click to add title

fiif

e Atur data tabel dengan mengeklik ikon E5. Data chart dapat diedit pada

kolom Categories dan Y-Values.

baris/kolom
®
Categories | Y¥-Values |
1 |Bali 20
5 |Sumatra 14 == Jumlah peserta
2 |Jawa 30
4 [ Sulawesi 10

Berikut adalah hasil chart pada slide setelah diatur datanya pada langkah

sebelumnya. Di sebelah kanan chart terdapat legend.

Data label
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Untuk menampilkan atau menyembunyikan legend menggunakan ikon ='.
Untuk mengedit legend, klik dua kali legend dan atur tampilannya.

Pengaturan legend ditunjukkan gambar berikut.

Borders |Are,a |Transparer1q,r |For'|t | Font Effects |Posi‘tior1 |

Line properties
Style

Width

0.00 mm S

Transparency

ne
U -

Untuk mengedit area pie, klik dua kali pie, lakukan pengaturan pada

tampilan gambar berikut.

|Opti0ns|ﬁrea |Transparenq,r IBorders |

Fill

Coler u

n
I Chart 2
[ cChart3
I Chart 4
I Chart 5
[ Charte
B Chart 7
[ Chartg
I Chart 9
[ Chart 10
I Chart 11
I Chart 12 v

Untuk mengedit label, klik dua kali label dan lakukan pengaturan pada

tampilan gambar berikut.

42




Modul Diklat Guru Pembelajar

Data Labels Font | Font Effects |

O

Show value as percentage | Percentage format...

Mumber format...

Show category

[] Show legend key

Placement m

Rotate Text

vl
\\ f/

ABCD

Degrees

L
Frent

s ~
o)

Menjalan presentasi

Untuk

menjalankan

presentasi

dilakukan melalui menu

Slideshow->Slideshowatau dengan menekan tombol F5 pada keyboard.

Untuk mengatur presentasi mulai dari slide mana dilakukan melalui menu

Slide Show | Window Help

|

Slide Show F5

al
i

&y

ol

Slide Show Settings...

Rehearse Timings

Interaction...
Custom Animation...

Slide Transition...

Show Slide

Hide Slide
Custom Slide Show...

Slide Show Settings.
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Range oK
) All slides |—|
Custom Slide Show

Type————————— Options
[] Change slides manually

[ Mouse pointer visible

[] Mouse pointer as pen

| Navigator visible

Animations allowed

Change slides by clicking on background

Show logo

[] Presentation always on top

Multiple display

Presentation display

Menyimpan Presentasi

Setelah pembuatan presentasi selesai, simpan file presentasi melalui menu
File->Save as. Beri nama file dan tentukan tipe filenya kemudian klik tombol
Save. Impress menyediakan beberapa tipe file, baik tipe file standar
dokumen terbuka (ODF Presentation) maupun tipe file lainnya termasuk tipe

file PowerPoint.

Organize + New folder = - (7]
I Desktop A Name - Date modified Type ~
| Documents i

. assignment 07-12-201511:10...  File folder
& Downloads
.. Bakal fix 13-12-201512:52...  File folder
@'h mudanurul@out X
1 Musi . blocks 05-12-2015 2:38 PM  File folder
usic
X .. bleg 05-12-2013 237 PM  File folder
= Pictures §
. L. chat 04-12-20152:38 PM  File folder
B Videos
— s 10-12-201510:37 ... File folder
i WinTsys (C:) )
. dragmath 05-12-20152:34 PM  File folder
—u DATAT (Dv) y
L. equ 30-11-2015 %40 AM  File folder
—a DATAZ (E] -
Dn-—nu—h\nl‘\i—\,|v < e
File name: | Segitiga v
Save as type: | ODF Presentation (.odp) v
ODF Presentation (.odp)
ODF Presentation Template (.otp)
OpenOffice.org XML 1.0 Presentation (.sxi)
OpenOffice.org XML 1.0 Presentation Template (.sti)
Microsoft PowerPoint 97/2000/XP (.ppt)
Microseft PowerPoint 37/2000/XP Template (.pot)
OpenOffice.org XML 1.0 Drawing (OpenOffice Impress) (sxd)
Uniferm Office Format 2 presentation (.uep)
ODF Drawing (Impress) (.odg)
. Hide Folders swve | [ Cancel

N
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Aktivitas 2 : Membuat Tabel

Untuk mulai menggunakan Calc klik OpenOffice Calc.

OpenOfiice

Gambar berikut merupakan jendela utama Calc.

File Edt View Insert Format Tock Data Window Help -= Baris Menu

EgkE-d = Laiﬁi&-".ﬂﬁ KEE-¢d B-0 - @8 By HPEBEQ @ |
P [ana vffw M BrU === HhxPLM e 0-2-A-)
K Y KE = | A ()

8 C | | E F | G H ]

3 i

EX Papan rumus Toolbar standar  Toolbar pemformatan
5

|

T

[+ |

]

| 10 |

| i

12

| 13 |

14

15

16

7

18
| 19 |
20|

2
| 2 |
|

! Sheet
| 25 |

26
[ 27 |

Ho b (v Sheett Sheetd [ Sheatd / €

Calc mempunyai fitur membuat tabel secara mudah. Misal akan dibuat tabel

berikut:
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Daftar Nilai Siswa

Nilai
No | Nama

akhir
1 Rina 80
2 Budi 76
3 Siti 85
4 Andi 78
5 Rima 80

Langkah-langkahnya sebagai berikut.

o Judul tabel dan kepala tabel diketikkan pada cell tertentu.

Daftar Nilai Siswa

No Nama Nilai akhir

o Mengetikkan isi masing-masing kolom/baris mengikuti kepala tabel.

No Nama Nilai akhir
1Rina 80
2 Budi 76
3 Siti 85
4 Andi 78
5Rima 80

e Langkah selanjutnya adalah performatan tabel, diantaranya pengaturan

alignment, merge cells, dan border sehingga menghasilkan tabel seperti
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pada tabel. Performatan bisa menggunakan tool di formatting toolbar.

Untuk pengaturan alignment melalui tool , penggabungan

sel menggunakan tool merge cells Igdan border menggunakan tool

Cell border:

Aktivitas 3: Fungsi Matematika

Calc mempunyai cukup banyak fungsi, diantaranya fungsi matematika, salah
satunya adalah Average. Fungsi tersebut untuk untuk menghitung nilai rata-
rata. Misalnya akan dihitung rata-rata dari nilai siswa . Untuk memudahkan

penggunaan fungsi dapat menggunakan wizard functiondengan cara klik ikon

# . Pilih fungsi AVERAGE, kemudian klik Next.

o eaewee B
Functions _ Function rESuIlI

Categary AVERAGE

Al [¥] | averacet number 1 number ;...

Function

ARABIC A

AREAS Returns the average of a sample.

ASC

ASIN

ASINH

ATAN

ATANZ

ATANH

AVEDEY

EEE@EE Formula Result IEmSEO

AVERAGEIF —

AVERAGEIFS = ~

B

BAHTTEXT -

v

(| Array | Help | ‘ Cancel | << Back I| Mext == ‘I | QK ‘

Pilih range cell yang akan dihitung rata-ratanya sehingga pada number 1

terdefinisikan cell mana saja yang dihitung rata-ratanya.
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Statistical [v]
No Nama Nilai akhir Function number 1 (required)
1 |Rina 8 [AVERAGE - Number 1, number 2;..are 1to 30 numeric arguments representing a
2 |Budi 7 AVERAGEA population sample.
P B oy = ~
3 [siti_ 8 T 3 | number 1 | f || E3EH @
4 Andi 7 BETAINY e ,ﬂ:
5 |Rima 3 BINOMDIST L ]
I I
Rata-rata number 3
CHINY
CHISQINV
CHITEST E—. Result[98
CONFIDENCE =
CORREL l:AVERAGE s
COUNT
COUNTA .
v
L] Armay | Hap | Camcdl | | <<Bock Next >

Klik tombol OK untuk memperoleh hasil rata-rata.
Aktivitas 4:Membuat Chart pada Calc

Salah satu fitur unggulan Calc adalah kemampuannya membuat grafik.

Misalnya ada data sebagai berikut:

DATA KELAHIRAN

No Tahun Jumlah kelahiran
1 2005 1200
2 2006 1000
3 2007 700
4 2008 800
5 2009 500
6 2010 1100
7 2011 1050
8 2012 350
9 2013 200
10 2014 100

Data tersebut akan dibuat chart. Untuk membuat chart pada Calc, langkah-

langkahnya sebagai berikut.
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e Klik menu Insert=> Chart atau ikon i .

e Pilih tipe chart, misal dipilih tipe Column, kemudian klik OK.

X
Es Bar
e Pie
L& Area
“ Line Mormal
l."_-.'; XY (Scatter)
Eﬁ Net Shape
|E:_n Stock
1) Cotarmn ond Line I—
Cone
Pyramid
| OK | | Cancel ‘ | Help |

e Selanjutnya adalah memilih data chart. Untuk memilih range data, klik

bagian yang ditandai merah pada gambar berikut.

Steps Choose a data range
1. Chart T Data range
. Chart Type
Sheet1.51514
[Shec1 ‘]
3. Data Series (®) Data series in rows

4. Chart Elements () Data series in columns

First row as label

First column as label

| << Back | | Next = | | Finish | | Cancel |

Pilih cell yang memuat data yang akan dibuat chart dengan data seri

pada baris. Pilih semua cell termasuk kepala tabel.
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Tahun  |Jumlah kelahirar

2005 1200 Steps Choose a data range
2006 1000 Rer e Data range

2007 700 === 55heet1.SC55:5D519
2008 800 3. Data Series (®) Data series in rows
2009 500 4. Chart Elements () Data series in columns
2010 1100 [¥] First row as label
2011 1050 First column as label
2012 350

2013 200

2014 100

e Tentukan data serinya.

Steps Customize data ranges for individual data series
Diata zeries Data ranges
1. Chart Type
200 ~ | (NEE $Sheet].3C56
2.Data Range 2006 ¥-Values §5heet1.5D36
201
2008
4. Chart Elements 2009
2010
2011 Range for Name
2012 v | | ssheet1.5cs6 |
Add A Categories
Sheet1.5DS5 =
[] (s =
o |t [ B || o |

e Langkah selanjutnya menentukan Chart elements. Atur judul, legend,
grid. Pengaturan judul untuk judul chart, judul sumbu x, y. Legend bisa
ditampilkan atau disembunyikan. Posisi legend dapat berada di kiri,
kanan, atas dan bawah. Grid untuk sumbu x dan y juga dapat

ditampilkan maupun disembunyikan.
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Steps Choose titles, legend, and grid settings
i i Display legend

1.Chart Type Title |Jum|ah Kelahiran |
2.Data Range Subtitle | | (O Left
3. Data Series (O] Right
4. Chart Elements A axis |Tahun | O Top

¥ anis |Jum|ah | () Bottom

Z axis | |

Display grids

[ X axis 1% Z aviz
=

e Gambar berikut adalah chart yang dihasilkan di mana chart memiliki
pengaturan yang dilakukan pada langkah-langkah sebelumnya,
diantaranya posisi legend di sebelah kanan, adanya judul, judul untuk

sumbu x, y, tidak ada grid untuk sumbu x, y.

Jumlah Kelahiran

1200
m 1000
1000 m 2007
2008
800 2009
% 600 2010
E 2011
400 2012
" 2013

0 Llend
Tahun
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Menyimpan file

Untuk menyimpan file Calc melalui File->Save as kemudian beri nama file
dan tentukan tipe filenya. Untuk format dokumen standar Calc menggunakan

tipe file ODF Spreadsheet (.ods).

#m Desktop ~ Name Date modified Type 2
;] Documents X X
4 Downlosd . assignment 07-12-201511:10...  File folder
ownloads
| Bakal fix 13-12-201512:52...  Filefolder
LF mudanurul@out )
b Musi . blocks 05-12-2015 259 PM  File folder
usic
. . blog 03-12-2015 237 PM  File folder
= Pictures )
) . chat 04-12-2015 238 PM  File folder
H Videos )
P M CS 10-12-201510:37 ... File folder
(y WinTsys (C:) .
. dragmath 05-12-2015 2234 PM  File folder
= DATA1 (D) )
L. equ 30-11-2015 %:40 AM  File folder
ca DATAZ (E) v
v £ >
File name: | Nilai kelas 1 ”
Save as type: | ODF Spreadsheet (.ods) W

ODF Spreadsheet (.ods)

ODF Spreadsheet Template (.ots)
OpenOffice.org XML 1.0 Spreadsheet (.sxc)
OpenOffice.org XML 1.0 Spreadsheet Template (.stc)
Data Interchange Format (.dif)

dBASE (.dbf)

Microsoft Excel 97/2000/XP (xls)

Microsoft Excel 97/2000/XP Template (xlt)
Microsoft Excel 95 (xls)

Microsoft Excel 95 Template (xlt)

'+ Hide Folders Microsoft Excel 5.0 (xls)

Microsoft Excel 5.0 Template (xlt)
[

Text CSV (csv)

HTML Document (OpenOffice Calc) (html)
Microsoft Excel 2003 XML {xml)

Uniform Office Format 2 spreadsheet (uos)

E. Latihan/tugas

1. Fitur OpenOffice yang berfungsi untuk membuat slide presentasi adalah

a. Impress c. Base

b. Calc d. Writer
2. Jenis animasi yang mempunyai arah masuk disebut ....

a. Exit c. Emphasis

b. Entrance d. Motion path
3. Pengaturan tata letak slide ada pada menu ....

a. Slide layout c. Slide transition

b. Slide design d. Duplicate slide
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lkon E= digunakan untuk ....
a. Tabel c. Fungsi

b. Chart d. Draw

Ikon 5 digunakan untuk ....
a. Tabel c. Fungsi
b. Chart d. Draw

Pada proses pembuatan chart, untuk mengatur judul, legend, ada pada

menu ....
a. Chart elements c. Chart title
b. Chart legend d. Chart subtitle

Tipe file standar dokumen Impress adalah ....

a. .ods c. .odp
b. .odt d. .otp

Tipe file standar dokumen Calc adalah ....

a. .ods c. .odp

b. .odt d. .otp

F. Rangkuman

Impress merupakan layanan OpenOffice yang digunakan untuk pengolah
presentasi multimedia, sedangkan Calc untuk pengolah angka.

Impress mempunyai kemampuan membuat slide presentasi dengan teks,
gambar, chart, formula, multimedia berada di dalam slide tersebut.

Calc mempunyai kemampuan membuat tabel, menggambar grafik,

mengolah data angka dengan fungsi-fungsinya.
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G. Umpan Balik dan Tindak Lanjut

Setelah Anda mempelajari materi dan mempraktekkan aktivitas
pembelajaran silahkan mencoba menjawab latihan. Cocokkan jawaban Anda
pada kunci jawaban. Jika Anda masih kesulitan dalam mengerjakan aktivitas
pembelajaran Anda bisa membaca kembali uraian materi di kegiatan
pembelajaran ini. Jika Anda dapat menjawab pertanyaan dengan betul pada
latihan tersebut berarti Anda sudah menguasai materi yang ada di modul ini
dan dapat melanjutkan mempelajari modul berikutnya. Jika belum
terselesaikan semua, ulangi kembali untuk dapat memahami materi yang

disampaikan.

H.Kunci Jawaban

©® N o ;e W N
(@]
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Kalkulator

A. Tujuan

Peserta pelatihan dapat memanfaatkan kalkulator jenis scientific dan

kalkulator grafik + cas untuk pembelajaran matematika.

B. Indikator Pencapaian Kompetensi

Setelah menyelesaikan pembelajaran pada modul ini peserta pelatihan dapat:

1. menjelaskan fungsi - fungsi tombol dan menu pada kalkulator ClassWiz
fx 570 - 991EX dan kalkulator fx - CP400

2. mengaplikasikan fungsi kalkulator ClassWiz fx 570 - 991EX dan
kalkulator fx - CP400 pada topik - topik aritmetika, aljabar, geometri,

kalkulus dan statistika

C. Uraian Materi

Teknologi merupakan sarana yang penting untuk belajar dan mengajar
matematika. Banyak sarana teknologi informasi dan komunikasi (TIK) yang
dapat digunakan sebagai media pembelajaran matematika, tetapi dalam
pembahasan ini akan dibatasi pada sarana TIK berupa kalkulator. Sejak 1976,
NCTM telah mempublikasikan bermacam-macam artikel, buku-buku, dan
pernyataan posisi, yang menyarankan penggunaan kalkulator secara reguler
dalam pengajaran matematika pada semua tingkatan. Pada pernyataan
posisinya tahun 2005 tentang perhitungan dan kalkulator, NCTM
menjelaskan pandangannya bahwa ada tempat yang penting dalam
kurikulum untuk pengunaan kalkulator dan pengembangan berbagai jenis

keterampilan perhitungan (www.nctm.org).
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Berikut ini beberapa keuntungan penggunaan kalkulator dalam

pembelajaran matematika

1. Kalkulator dapat digunakan untuk mengembangkan konsep dalam
pembelajaran di kelas.

2. Kalkulator dapat digunakan untuk drill

3. Kalkulator meningkatkan kemampuan pemecahan masalah

4. Kalkulator dapat digunakan untuk belajar mandiri (khususnya kalkulator
yang memiliki mode cek) sehingga pengguna bisa mengetahui apakah
langkah-langkah yang dilakukan sudah benar atau ada kesalahan.

5. Kalkulator menghemat waktu pembelajaran matematika di kelas.

Pada modul ini akan diperkenalkan dua jenis kalkulator yaitu kalkulator

scientific dan kalkulator grafik + cas.
a. Kalkulator Scientific

Secara umum kita dapat membedakan kalkulator yang berada di pasaran saat
ini dari kemampuannya melakukan perhitungan. Ada tiga kategori

kemampuan kalkulator :

1. Kemampuan melakukan perhitungan numerik

2. Kemampuan menggambar grafik

3. Kemampuan melakukan perhitungan simbolik atau computer algebra
system (cas)
Kalkulator scientific hanya memiliki kemampuan melakukan
perhitungan numerik, dan sebagai contoh dari kalkulator scientific yang
akan kita gunakan pada modul ini adalah casio classwiz fx - 570/991EX.
Untuk pembelajaran pada modul ini anda dapat mendownload emulator

dari kalkulator ClassWiz fx - 570/991EX di website casio education

Langkah 1 : ketikkan alamat situs

https://edu.casio.com/freetrial/en/freetrial list.php pada browser anda,

kemudian pada ClassWiz Emulator Subscription v1.00 (pada saat modul ini

dibuat) pilih fx - 570/991EX Emulator selanjutnya klik tombol download



https://edu.casio.com/freetrial/en/freetrial_list.php

Modul Diklat Guru Pembelajar

= a X
% DesktoplandingPage X Download Free Trial Version /... X =
€ | @ CASIO COMPUTER CO, LTD. (P) | [ e e e c| Q Search w B8 ¥y 4 0 =

Home > Download Free Trial Version / Subscription Series

Download Free Trial
Version / Subscription
Series

The CASIO software has the identical basic functionality as the corresponding
popular school calculators and is best suited for lesson preparation and the
use at school

The software of the subscription series can be turned into a one year licence
after a 90 days trial period

Subscription Series (Activation Supported)

ClassWiz Emulator Subscription v1.00
fx-570/991EX Emulator

(90 Day Trial) for Windows®

Go here for the model code that is required for the silent uninstall
Please check the svstem reauirements from this section.

Lengkapi (pilih) data Occupation dan Country yang sesuai, kemudian klik
download

@ Download Free Trial Version / Subscription Series - CASIO WEW Worldwide Education Website - Mozilla Firefox

#4 | https://edu.casio.com/freetrial/en/freetrial_form.php

CASIO WEW Worldwide Education Website Testsize

Small  Large

Download Free Trial Version /
Subscription Series

Input the information below to get the trial version.
Fields marked with an * are required

@ Teacher Upper secondary school v
Occupation * O Student/Pupil [ Choose from list |
O Others [ Choose from list | v
Country: Indonesia

D T

 Close

©2015 CASIO COMPUTER CO., LTD.

Langkah 2 : setelah terbuka jendela window untuk download (tampilan

pada browser mozilla firefox), klik “OK”
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Opening fx-570EX_991EX_sub_100_2a.zip X
You have chosen to open:

¢ fx-570EX_991EX_sub_100_2a.zip

which is: Compressed (zipped) Folder
from: https://edu.casio.com

What should Firefox do with this file?

(O Openwith | Windows Explorer (default) v

@ Save File

Do this automatically for files like this from now on.

OK ‘ Cancel |

Langkah - langkah instalasi emulator ClassWiz fx - 570/991EX

Langkah 1 : Double klik file setup ClassWiz Emulator Subscription for fx -
570EX_991EX

. a X

-0
@l e
| {Icaven][shows Options
2 view~ hide~ %
€« o > Mod... » fx-570EX... v & | Searchfx-570EX 991.. 0
st Quick access
& Downloads * q
-~
buttonKelkulator ]
I Desktop
ModulP4TK ClassWiz
Emulat
| MOS_BPTIKP Subscription for
-5T0EX 991X ..
7 OneDrive

B This PC g
1item B:
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Langkah 2 : klik tombol selanjutnya (next) dan ikuti wizard instalasi sampai

dengan klik tombol selesai (finish)

ption for fx-571

X %) ClassWiz Emulator Subscription for fx-570/991EX - InstallShield Wizard X

Selamat datang di InstaliShield Wizard untuk Pemeliharaan Program
ClassWiz Emulator Subscription for | i i
x-570/991EX

program.

InstalShield(R) Wizard akan memungkinkan Anda untuk

‘
|
atau ClassWiz I -
Emulator Subscription for fx-570/391EX . Untuk melanjutkan, 1 & petota
Kik Selanjutnya.

d kesalahan instalasi di dalam program. Piihan ini akan
memperbaiki file-fil, shortcut, dan entr registri yang hiang atau rusak.

O Keluarkan
Keluarkan ClassWiz Emulator Subscription for fx-570/391EX dari
komputer Anda.
[ el [senimya>] | estaken | <Kenbai _|[Selaryiya> | | sataken
) ClassWiz Emulator Subscription for fx-570/991EX - InstallShield Wizard X ) ClassWiz Emulator Subscription for fx-570/991EX - InstaliShiel... — X
Siap untuk memperbaiki program Menginstal ClassWiz Emulator Subscription for fx-570/99:
Wizard siap untuk memulai instalasi. Fitur-fitur program Yang Anda pilh sedang dinstal.
Kik Instal untuk memulai instalasi. Silahkan menunggu sementara InstaliShield Wizard menginstal ClassWiz
Emulator Subscription for fx-570/99 1EX. Ini ak kan waktu beberapa
Jika And: atau mengubah instalasi Anda, kiik Kembali. Kiik menit.
Batakan untuk keluar dari wizard.
Status:
[ ]
[ ]
| <kembaii [ sl ]| Bataken [ <Kembal || Selariitmya > | [ Batakan |
) ClassWiz Emulator Subscription for fx-570/991EX - InstallShield Wizard X

~ InstaliShield Wizard Selesai

Qo

InstalShield Wizard teleh berhasi menginstal ClassWiz Emulator
Subsaription for fx-570/91EX . Kik Selesai untuk keluar dari
wizard,

<kembal [ _selesal Batakan
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Setelah ClassWiz terpasang (terinstal) pada PC/laptop, sekarang anda dapat
menjalankan emulator ClassWiz fx-570/991 EX.

B o id
Y g g g BERg

1:Calculate

T T YR s
e EEs B g %3 o 5% 4004

o o e (i 8:Spreadsheet

STO | ENG ( ) SO0 | M+

[ 7 | 8 | o JEESRFE N
(456 x]-]
T ma oo

Equatlnanunc

Kalkulator classw1z fx - 570/ 991EX memiliki beberapa mode yang memiliki

fungsi,

> o ©® N o vtk W

S

Calculate : melakukan perhitungan standar matematika

Complex : melakukan perhitungan dalam bilangan kompleks

Base - N : melakukan konversi bilangan dalam berbagai basis

Matrix : melakukan perhitungan matriks

Vector : melakukan perhitungan vektor

Statistics : melakukan perhitungan statistik

Distribution : fungsi distribusi statistik

Spreadsheet : pengolah angka dan analisa data

Table : menentukan daerah hasil suatu fungsi dengan domain tertentu
Equation/Func : penyelesaian sistem persamaan linear ( 2 - 4 variabel)
dan menghitung akar - akar persamaan sukubanyak berderajat 2 - 4.
Inequality : penyelesaian pertidaksamaan sukubanyak berderajat 2 - 4

Ratio : perhitungan masalah perbandingan
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b. Kalkulator Grafik +CAS

Kalkulator grafik + cas merupakan jenis kalkulator yang memiliki
kemampuan lengkap, yaitu dapat melakukan perhitungan numerik,
menggambar grafik dan dapat melakukan perhitungan simbolik (cas). Pada
pelatihan ini sebagai contoh dari jenis kalkulator grafik+ cas akan digunakan
kalkulator fx - CP400. Emulator kalkulator ini dapat anda download di

http://edu.casio.com/products/cg/cp2/trial.html

Download
Bl 90 Day Trial

A collection software that will come in

Langkah - langkah download dan instalasi emulator fx - CP400 kurang lebih
mirip dengan proses download dan instalasi emulator ClassWiz fx -

570/991EX.
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Berikut ini fitur -

Main
eActivity
Statistics
Spreadsheet
Graph & Table
3D Graph
Geometry

Picture Plot

Interactive
DiffCalc

Conics
DiffEqGraph
NumSolve
Sequence
Financial
Program
Communication
System
Physium

fitur yang dimiliki oleh kalkulator fx -CP400

untuk melakukan perhitungan numerik dan simbolik
untuk melakukan semua aktivitas matematika

untuk melakukan perhitungan - perhitungan statistik
fasilitas pengolah angka

untuk menggambar grafik dengan banyak fungsi
menggambar grafik 3d

melukis bangun - bangun geometri datar

insert gambar untuk dianalisa secara matematika
analisa kurva turunan secara interaktif

Irisan kerucut

grafik persamaa dinfferensial

penyelesaian persamaan secara numerik

persamaan rekursif

hitung keuangan

pemgrograman kalkulator

transfer file kalkulator dengan fx-cp400 manager pada PC
pengaturan sistem pada kalkulator

tabel periodik dan konstanta-konstanta fisika
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D. Aktivitas Pembelajaran

Pada aktivitas pembelajaran ini kita akan mengeksplorasi kemampuan
kalkulator ClassWiz fx - 570/991EX dari sisi kemampuan melakukan
perhitungan numeriknya, sedangkan pada ClassPad fx - CP400 kita akan
melihat tiga kemampuan, yaitu perhitungan numerik, menggambar grafik

dan perhitungan simbolik (CAS).

Setiap masalah dari aktivitas pembelajaran akan dibahas dengan kedua
kalkulator tersebut, fokus pada aktivitas pembelajaran ini adalah mengenali
kemampuan teknologi yang dimiliki oleh kalkulator ClassWiz fx - 570/991
EX dan ClassPad fx CP400. Setelah cukup menguasai kedua kalkulator
tersebut Anda diharapkan dapat mengembangkan materi dan strategi
pembelajaran yang tepat ketika kalkulator diperbolehkan digunakan oleh
peserta didik di kelas.

Aktivitas 1 : (Bentuk Akar)

A14:)1)
3+242

Bentuk sederhana dari adalah ...

Jawab :

Classwiz fx - 570/991EX

Pada pembilang, 4(1 + ﬁ)(l - xﬁ) kita sederhanakan menjadi

4(1442)(1-42)
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4(1+s2%)(1ps2%)=

untuk menyederhanakan penyebutnya, bentuk (3+2\/§) dikalikan dengan

sekawannya yaitu (3 —2\/5 ) sehingga (3 ; «/E) sama dengan ...
+
VEr [ A
1, 3-2{2
3+2{2 3-2¢2

3-242

alR3+252$$0a3p2s2R3p2s2=

A14-)1-)
3+242

Jadi

sama dengan ...

1(1443) (1-43)
3+24{2

-12+842
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ClassPad fx - CP400

Kalkulator ini memiliki fitur verify yang dapat memeriksa langkah-langkah
yang kita lakukan, di sini kalkulator berperan bukan sebagai alat hitung
tetapi sebagai pemeriksa, apakah yang langkah yang kita lakukan benar atau

salah. Fitur ini bermanfaat untuk membangun keterampilan peserta didik

dalam melakukan perhitungan - perhitungan baik numerik maupun
simbolik.
[{ default-1 = O X B default-1 - O X
Menu Resize Swap Keyboard Menu Resize Swap = Keyboard
& File Edit Action (X & File Edit Action
ole e[ [=CIMmL  [o]a == T
4-(1+V2)-(1-V2) B8 4-(1+v2)-(1~V2) 4]
3+2.V2 3+2+V2
=[4-(1+v2)-(1-V2) 3-2-V2 =4-0+/2)-(1-V2)  3+2+V2

3422 3-2+V2

P ERROR!
" Sorry, not equivalent

A(142)1- 2
3+2\/§

Untuk menyederhanakan bentuk , langkah - langkah

adalah sebagai berikut ...
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£ File Edit Action

OlE|R|v[=|r

4-(1+2)-(12)
3+3 2

=4-(1+/2): (1-V2) 3-2+2
3+2+V2 3-2+v2

BEOoGE

4+(14¥2)-[12)

4
34242
=4 (1+2)-(1-v2) 8-24/2
342+V2 3-24v2
v

I[EJ

I@

= 4-(1-2)-(3-2+/2)
9-8

Il
=
<l I
[}
=

Line| = | ym | = >
0" | e® | In |loggd| YO
(M| x® | x' [logw(W)|solvel
OO0 toDMS| {2 | 13 | ()

Line| = | vyl | = &
e® | In (loggd| O

(W | x® | x™ |log(W) solve(

BOO toDMS| (™ | €3 | ()

. gin | cos | tan
sin | cos | tan

‘+|%|%|ans‘ﬂ£| | |'|*|%|%‘EHS‘EE|
Expr{ (4« (1R (20 (1= (20))/ (342« (@

Expi{ (4 (1R (2D (1= (20))/ (342 @

¢ File Edit Action (%] ¢ File Edit Action (%]
Cla[=[ =T | [cle[=[[=[Tmm_

4-(12)-(142) 4-(12)-(142)

4] 4]
342V 32 342V 32
=4.-(1+V2)-(1-V2) 3-2+v2 =4.-(1+V2)-(1-V2) 3-2+v2
342V 2 3-2+v2 342V 2 3-2+v2
= 4-(1-2)-(3-2+v2) = 4-(1-2)-(3-2+v2)
9-8 9-8
= 4.(=1)-(3-2-V2) = 4 (=1)-(3-2-v2)
v v
m m

1 1
=0 =-12+48+V2

=0

Exp: ({4 (14 (2D (1= (2)))/ (342 Exp: ({4 (14 (2D (1= (2)))/ (342
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Aktivitas 2 (logaritma)

3 2 2
Nilai dari (10g36) ~(*1og4) ...

*log 12

Jawab:

Classwiz fx - 570/991EX

vir @ A
log;{36)°—1log,{4)?
log,(412)

8

ai3$36$dpi3$4$uodRi3$s12=

ClassPad fx - CP400

(3log36)2 —(310g4)2

*log12

logaritma berikut ‘log(a-b)="loga+ logb, ”log(%j ="’loga—"logh dan

Untuk menyerhanakan bentuk

gunakan sifat - sifat

plog(a" ) =n-"loga

£ File Edit Action & File Edit Action
[D|H|R|'|¥|'- OIA|R|v|7F|r
(log5(36) ) 2-(logg() )2 = (1085036 ) 2-(logg( )2 [
logy(V12) logy (v12)
=[ ls5(4) )+(log5(36) ~logy (4. =‘|53(4) )+ (lo83(36) ~logg (4]
"'| logo (v12) " logq(V12) g
= 1084 (144) -log4(9) = log, (144) *log,(9)
i TX o caay
5+logg(12) 7log5(12)
=n = 2+log,(12) +2¢log4(3)
1
7+logg (12)
=22
1
z
=8
| )| pe— | = ] —
Exp:((( 10g(3,36)(D)-( log(3,4))* @ Exp((( 1og(3,380(D)-( log(3,4))" @@
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Aktivitas 3 (Sistem Persamaan Linear Dua Variabel)

Wati membeli 4 donat dan 2 coklat seharga Rp6.000,00. Tari membeli 3
donat dan 4 coklat dengan harga Rp10.000,00. Jika Andi membeli sebuah
donat dan sebuah cokelat dengan membayar Rp5.000,00, uang kembalian
Andi adalah ...

Jawab:

Model matematika dari masalah di atas adalah sistem persamaan linier dua

variabel berikut,

4x+2y=6000
3x+4y=10000

Classwiz fx - 570/991EX
Untuk menyelesaikan sistem persamaan linier, kita gunakan menu A :
A . .
UPIYPT PlPS 0
R 5 goog )|

Equatlnanunc

masukkan koefisien - koefisien sistem persamaan dua variabel

Vi [ =gl v
{ du + 2y= G000 X=
gx + 4y
10000 400
maka harga sebuah koper dan dua tas adalah
Ve A vEe A
¥= 5000-(400+2200)
2200 m 2400
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keylog :

ElapsRad £666024494 =10000===w15000p(400+2200)=
Pada aktivitas ini kita akan melihat kemampuan ClassPad fx - CP400 untuk
menyelesaikan sistem persamaan linier secara langsung, menggambar grafik

dan dalam melakukan perhitungan simbolik - CAS (menu Main)

# Edit Action Interactive

a6 Jitafsm] [ o[- T

[4x+23-=60[]l]
32c+dy=10000 |, 3
{x=400, y=2200}
5000~ (x+3) |ans
2400
1]
v |
Mathl || [ine | = | vl | = & ‘
Math2 ||pefine f s i .
et ootve(| asiv | + ({2 |
L Trg_ <> Oy n
[i < |lz2|=|%] ¢
abe
T

|+||%|%] ans|E}{E‘
Alg Standard  Real Rad =
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atau dengan perintah Action - Equation/Inequality - solve

r"" Edit [AGtion] Interactive £ Edit Action Interactive
%81 | & » Transformation iy lé%]@j,“ﬁ]lﬁmlf‘_‘*ylvl%lvl
Advanced »
D calculation 8 |[solve({4x+2y=6000, 3ac+dy=[p| 0
Complex 4 {x=400, v=22003}
List 4 5000-(x+y) |ans
Matrix » 2400
L] — D
Assistant dSolve
Distribution/Iny rewrite n
- Financial exchange
[Maﬂ'ﬁ Command eliminate Line| = | yH | @ | #
Math2 Definel f absExpand Define| f p ;
andConnect
"‘Tar‘iha solve(| dSIv | 1 getmight sove(| astv |+ [ (%2 |
9 > | (|getLeft < | > lolaln
Var f
< | 2 | dkodic ’ < |l 2| =2
abc [ | |
"<-|||ans|EXE‘ |+|%|% ans|E){E‘
Alg Standard  Real Rad | Alg Standard ~ Real Rad = @@

fx - CP400 dapat menyelesaikan sistem persamaan linier dua variabel

dengan metode grafik,

& Edit Action Interactive & File—Edit-ViewDraw (]
R ) % G | O 220 B P
KRN +45=10000FIRE IR 22 - | [4D00, 3x+43=100003, {x, ¥}) [

{x=400, y=2200} {x=400, y=2200}
5000~ (xc+y)\ans 5000-(x+y) |ans

2400 2400
0 o
klik dan drag

\¥=n | .

v

Alg Standard Real Rad = m

—{400,2200] Lo
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Kitapun dapat menampilkan

langkah-langkah penyelesaian

persamaan linier (metode eliminasi atau substitusi) dengan fx - CP400

sistem

# Edit Action Interactive

# Edit Action Interactive

(e [Rafsm]e [ o [ ]

(e [Rafsm]e [ o [ ]

pli=dx+2y=6000
dax+2+v=6000
p2:=3a+4w=10000
Sex+4y=10000
simplify { 2%pl-p2)
S+x=2000
ans/ 5
x=400
simplify { 3%pl—4%p2)
=10-y=—22000
ans/f (=10}
y=2200

pl=4x+2y=6000

Alg Standard Real Rad

O O
d+x+2+y=6000
p2:i=3x+43=10000
Fex+4-w=10000
pl-dx
Zey=—d+x+6000
ans/2
Y=—(4*xEBUUU)
(simplify (p2 | ans)~12000) / (-}
x=400
y= -(4*1-:;8[]00} | ans
y=2200
0
7] [+
(m (m

Alg Standard Real Rad

Aktivitas 4 (Matriks)

1 2
A= dan

(A-B) =B*.A™

Diketahui

Jawab :

-6
B=
3

Untuk melakukan perhitungan matriks maka kita gunakan menu 4 : Matrix

Define Matrix
1:MatA 2:MatB
3:MatC 4 :MatD

-5
4 J Tunjukkan bahwa
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definisikan matrix A dengan ordo 2 x 2

|

Math Math
Number of Rows? Number of
Columns?
Select 1~4 Select 1~4
m
Math= 5 1:Define Matrix I
G — 2:FEdit Matrix

4

J:Matrix Calc

kemudian definisikan matriks B dengan ordo 2 x 2

L

Define Matrix‘ MatB
1:Mata 2:MatB Number of Rows?
3:MatC 4 :MatD
Select 1~4
< m
MatB MatE= . -
Number of [ 5 —m]
Columns?
Select 1~4 4
hasil perhitungan (4- B)_1
m _ _ m
(MatAxMatB>Y ”ﬂ%;mf L.s
-1.12

hasil perhitungan B -A™"

MatBﬂiMatﬂﬂl

Mathns=
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Jadi (A-B) ' =B"-A"

keylog :
W41221=2=3=4=T122226=25=5=4=T3(T30T4)u=T4uOT3u=

ClassPad fx - CP400

langkah - langkah untuk menunjukkan (A- B)f1 =B'.A"

£ File Edit Am:lon £ File Edit Action

BCIDNE " IIBIRIIEFI

E]
B g -51"[ 0
(N A
iz | fh
1:(=6)42+5 1+(~5)+2+4 o —
| 3-(=6)+4+5 3+(=5)+d-4 25°|-5 -] 46" 31
=ra 3771 - ]
5 1) Sole -
=1 1 -3 = s
ﬁ'[—z:l] 4+(=2) +5- 41+5[
=[_1 3 —5e(- 2)—5——5 1-6- [-—
2 2
1 -2 =713
- 7 2
=0 1 -2
¥ v
]

=p

ExpiC[1,20, 13,41 [1-6,-50,(5, 41y~  @@| [EXPLI-B.-51[5,411°(-1)+[11,2],[3.,4

Aktivitas 5 (Penyelesaian Sistem Persamaan Liniear 3 Variabel dengan cara

Matriks)

Pada toko buku “Murah”, Adil membeli 4 buku, 2 pulpen dan 3 pensil dengan
harga Rp26.000,00. Bima membeli 3 buku, 3 pulpen, dan 1 pensil dengan
harga Rp21.500,00. Citra membeli 3 buku dan 1 pensil dengan harga
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Rp12.500,00. Jika Dina membeli 2 pulpen dan 2 pensil, maka ia harus

membayar ....

Jawab :

Model matematika untuk permasalahan di atas adalah sistem persamaan

linier tiga variabel

4x+2y+3z=26.000
3x+3y+z=21.500
3x+z=12.500

Classwiz fx - 570/991EX

Kita akan menyelesaikan sistem persamaan linier tersebut dengan cara

matriks

4 2 3\ x 26000 X 4 2 3\ (26000
3 3 1| y|=|21500 |<| y|=|3 3 1| - 21500
30 1)z 12500 z 3 0 1 12500

Untuk menentukan penyelesaian sistem persamaan linier dengan cara

matriks kita gunakan menu 4 : Matrix

it T g 38 JIER | DofinS Meinix .
B glihgd Mg By 3:MatC  4:MatD

4:Matrix

masukkan matriks A dan matriks B, dimana A-X=B

m m
Math= MatE=
— z 2
[ 2 3 1 ] [ 21300
3 0 1 12500
4 26000
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X
nilai X =| y | dapatditentukandari X=A4" B
z
13 Matins=
MatA-'xMatHl e
2000
2000
3500
m D]
Mathns= Mathns=
[ BSDD] 3500
[ Ea0 3000
2000 [T
3000 2000

keylog :
Ww413=34=2=3=3=3=1=3=0=1=T123126000=21500=12500=T3T3uOT4=

ClassPad fx - CP400

Penyelesaian SPL dapat ditentukan dari A-X=B=>X=A"-B

% Edit Action Interactive
it e e swe o[ T+ T
la 3 1J4A D
301
4 2 3
[3 3 1‘
301
26000
[2150ﬂ 2B
12500
26000
[21500
12500
A*(-1)xB
3500
| [EUUU
2000
p [ ¥
Alg Standard  Real Rad (]

L) 8 -J
\/ = AR VLU
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Aktivitas 6 (Penyelesaian SPL tiga variabel dengan cara determinan)

Ani, Nia dan Ina pergi bersama-sama ke toko buah. Ani membeli 2 kg apel, 2

kg anggur

dan 1 kg jeruk dengan harga Rp67.000,00. Nia membeli 3 kg apel, 1 kg

anggur, dan 1 kg jeruk dengan harga Rp61.000,00. Ina membeli 1 kg apel, 3

kg anggur dan 2 kg jeruk dengan harga Rp80.000,00. Harga 1 kg apel, 1 kg

anggur dan 4 kg jeruk adalah ....

Jawab:

Model matematika untuk permasalahan di atas adalah sistem persamaan

linier

2x+2y+z=67000
3x+y+z=61000
x+3y+2z=80000

Classwiz fx - 570/991EX

Untuk menentukan penyelesaian dengan cara determinan, kita tuliskan

determinan-determinan matriks sebagai berikut

67000 2 1 2 67000 1

X

w)
Il
_,w N

2 1
1 1|,D
3 2 80000 3 2 1 80000 2

dan penyelesaiannya adalah

D
x=&,y=—y,dan2=&,
D D D

2 2 67000

=/61000 1 1|,D,=|3 61000 1| danD,={3 1 61000

1 3 80000
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Pada kalkulator, kita definisikan terlebih dahulu matriks - matriksnya

Define Matrix Mats= : 5 ;
1:MatA  2:MatB O 1]
3:MatC 4:MatD ! ¢ —-—
2
m m
MatB= MatiC=
&T000 2 1 2 &T000 1
&1000 1 1 2 &1000 1
[ 20000 3 ‘] [ 1 280000 I
2 2
m m \
Math= > e7on0 Det (MatB)-Det (Mat
2 1 &1000 ﬂ}
1 3 EEDNDQ 12000
80000
m m
12000 18000
E?t{MatC}+Det{Mat E?t{MatD}+Det{Mat
18000 7000
keylog :

W41332=2=1=3=1=1=1=3=2=T123367000=2=1=61000=1=1=80000=3=2=T133
32=67000=1=3=61000=1=1=80000=2=T14332=2=67000=3=1=61000=1=3=800
00=T3TR2T4)PTR2T3)=TR2T5)PTR2T3)=TR2T6)PTR2T3)=
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ClassPad fx - CP400 (gunakan menu Main)

£ Edit Action Interactive £+ Edit Action Interactive
S | b | fba] siwe o | v | A4 vE e iafsme [ [ T T
221] 4] [z 67000 1‘
31 1|%A 3 1000 1
13 2] 1 80000 2
221 2 2 67000
[3 1 1‘ [3 1 61000 |3D
132 1 3 80000
67000 2 1 2 2 87000
[Eloﬂﬂ 11(*B 3 1 61000
80000 3 2 1 3 80000
67000 2 1 det(B) fdet (A)
{61000 1 1‘ 12000
80000 3 2 det (C) fdet (A)
18000
2 87000 1
[3 61000 1]:0 det (D) fdet (A)
1 80000 2 7000
. v
[2 67000 170 :
Alg Standard  Real Rad (m

Alg Standard FResl Red = (m

Aktivitas 7
1 5 4
Jika vektor a=| 2 , b=| 4 |dan c=| -1 | maka vektor a+2b—3c sama
3 -1 1
dengan ...
78 |
LA
{!"‘ "\ |
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Jawab :

Untuk melakukan perhitungan vektor gunakan 5 : Vector

- M Define Vector
iy &8 g BEle || [Sycts | S:veLB

mdﬂhdﬁﬁ 3:VctC 4:VctD

5:¥ector

definisikan vektor a, b dan c

YotA= 1E| YotB= 5E|
|
3 -1
YokiC= o
_*1‘]
| 1
1

hasil dari a+2b—3c

VCtA+2VetB—3Vet( || vetanss

-2

keylog :
w5131=2=3=T1235=4=z1=T1334=21=1=T3T3+2T4p3T5=
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ClassPad fx - CP400 (gunakan menu Main)

#+ Edit Action Interactive ## Edit Action Interactive
e b [iafsme] o [ [T | s JHRa]swe s [+ [ ]
1 4] [4 I#b 4]
2|2a =1
3 5
1 4
3 4
i |2b 1
_]_ 4
5 -1
4 1
-1 a+2b-3c
4 =1
=1 |%c 13
1 -2
[4 ]88 |B v
Alg Standard Real Rad = (@ &lg Standard Resl Rad = (@
Aktivitas 8

Grafik fungsi f(x) =x>-3x"-9x+15 turun pada interval ...

Jawab:

Dengan menu Table kita lihat domain dan Range fungsi f(x)




Modul Diklat Guru Pembelajar

A VEr @
Ygdldngd Mg B | fx)=x"-3x"-9x+15
R d 3 d D:Dd
9:Table
T bl\lﬁfﬁlR =D fen
able Range |
Start:-5 é 4 %E
End :5 4 -
Step :1 -5
VEr [ VEr [
F fimn F fimn
5 -1 20 2 2 -7
& u} 15 9 2 -1z
T 1 d 10 d -5
| - -7 11| — 20
2 5
keylog :

w9Q)"3$p3Q)dp9Q)+15==z5==

untuk menentukan interval dimana f (X) turun, kita akan menentukan

penyelesian dari f'(x) =3x*-6x-9<0

T . 1:ax2+bx+c>0 )
d Lt a—dﬂd Z2rax2+bhx+c<0
d X3 U“:'d 3:axZ+hx+c20
B:lnequality 4raxe+bx+c=0

V& B Vo B
axZ+hu+cid a<x<h

L Ex B -

-9 -14{x<3
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Keylog :

wQx223=26=29==

ClassPad fx - CP400

# Edit Zoom Analysis &

# Edit Action Interactive

T B B ) e t}_l» 05 1T dow [iba e [ 15 [ [ 40 v[
: define f(x)=ac%-322-9ar+15 > )
5 done
3 d
dx[f(x])
" I
3 A 3ex2—6x-9
ans<0
—10¢ 3
- |[% [ Jex“=B-x=9<0
sheet1[sheet2 Sheet3 [Sheet4 Sheets | solve (ans, %) (143
=1%X
Myi=3-gx2-gar15 —B) |
[v2:0 I
[J¥3:0
[Jy4:0
[1¥5:0
[dw6:0
Mez.n [v] [ v]
Rad  Real L Alg Standard  Real Rad = @
Aktivitas 9

1

Hitung nilai lim X
12 Jx+3°
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Jawab :

ClassPad fx - CP400

& File Edit Action (x]
EEIEEL

. 1-x B
xll}mll [2-\“x+3
T P
w31 L 2=Vx+3 2+ x+3
= im [z (2+Vx+3)
Xl')l. 4= (x+3)
lim [ (1-x)+(2+Vx+3)
[ v]

x21 1-x

= lim (2+Vx+3)
x>l

=2+/1+3
=2+2

=4

=0

Exp: lim(((1=x)/ (2= (x+30) %, 1) @

Aktivitas 10
Luas daerah yang dibatasi oleh kurva y=x*—-4x+4 dan y=2-x adalah ...

Jawab :
Classwiz fx

Luas daerahnya  dapat  dihitung  dengan integral  berikut

j(Z—x)—(xz —4x+4)dx

5 N[EgiD A
fl (2—x)—(x—dx+4)
1
6
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y(2pQ))p(Q)dp4Q)+4)R1E2=
ClassPad fx - CP400

£ Edit Zoom Analysis e £ Edit Action Interactive

3 A EE EE l[l‘_\_E 61 | b kg siwe | o | v | 44| v t
EE:?:T.SQT:& IShEEQTShEEﬂIShEF;i]]u j j (2-2)-(a-4xc+4) dx o
¥2=x2—fex+4 '—‘I 1
[1¥3:0 6
Ov4:0 o
(w0
[Cdw6:0

[ 170 n n
ko N Mathl | [ine | = | /m

b b ] |

\ | Math2 T | e" | In |loggd| T |

i \ [[ﬂ (W | %® | x (logelD so]ve(|

o WL Ty (= (}I

o Yar
[ abe sin | cos | tan | °© : |
| (vl |% s B
Rad Real Lo Alg Standard  Feal Rad = @@

E. Latihan/Tugas
o(3+48)(s-+6)
2+ Jg '
log\/6
(3log18)2 —~ ( 3logZ)2
3. Pada suatu hari, Pak Ahmad, Pak Badrun, dan Pak Yadi panen jeruk. Hasil
kebun Pak Yadi lebih sedikit 15 kg dari hasil kebun Pak Ahmad dan lebih

1. Sederhanakan bentuk

2. Hitung nilai dari

banyak 15 kg dari hasil kebun pak Badrun. Jika jumlah hasil panen ketiga
kebun itu 225 kg, maka tentukan hasil panen Pak Ahmad!

84
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1 2 4 3
4. Tentukan matriks X berordo 2 x 2 yang memenuhi ( 3 4 J-X =( ) 1 j!

5. Tentukan proyeksi orthogonal u= (1,3,3) pada v= (4,2,2).

6. Hitung nilai lim _ox+l

19 J4+ x+xP .

7. Tentukan interval dimana f(x)=x®+3x*—-9x—7turun!

32
8. Hitung Jx x*=2dx
N3

9. Tentukan luas daerah yang dibatasi kurva y=4-x*,y=—x+2 dan
0<x<2.
10. Tentukan volume benda putar yang terjadi bila daerah yang dibatasi oleh

kurva y=x* dan y=4x-3 diputar 360° mengelilingi sumbu X!
F. Rangkuman

Kalkulator  saat ini bisa dibedakan dari kemampuannya melakukan
perhitungan numerik, menggambar grafik dan melakukan perhitungan
simbolik. Dengan kalkulator grafik - CAS seperti ClassPad fx CP400, semua
area matematika bisa kita kita eskplorasi mulai dari aritmetika, aljabar,
geometry, statistika dan kalkulus. Fitur-fitur menarik yang ada pada
kalkulator ClassPad fx CP 400 seperti verify yang dapat memeriksa langkah -
langkah yang dibuat oleh pengguna dapat mendukung pembelajaran mandiri.
Kalkulator saat ini tidak bisa dipandang hanya sebagai alat bantu hitung
biasa, tapi sudah jauh bergeser sebagai media pembelajaran matematika

yang sangat powerful.
G. Umpan Balik Dan Tindak Lanjut

Gambaran kemampuan kalkulator scientific dan kalkulator grafik - CAS
secara umum dapat Anda pelajari pada uraian materi, untuk memahami dan
mengenali kemampuan kedua kalkulator tersebut dalam melakukan

perhitungan numerik, menggambar grafik dan perhitungan simbolik, lakukan
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aktivitas pembelajaran secara tuntas. Kemudian Anda bisa mencoba soal-soal
latihan yang ada pada modul ini, semua soal harus diselesaikan dengan
menggunakan kalkulator agar Anda dapat memahami semua perintah yang
ada pada kedua kalkultor dengan baik. Jika ada kesulitan dalam
menyelesaikan latihan, sebaiknya Anda mengulang aktivitas pembelajaran

yang sejenis dengan soal yang belum dapat Anda selesaikan.

Setelah semua soal latihan dapat dikerjakan dengan baik, Anda diharapkan
dapat mengembangkan lebih lanjut untuk membuat materi pembelajaran
yang tepat, sehingga kalkulator bisa digunakan sebagai alat bantu dan

meningkatkan kualitas pembelajaran.

H.Kunci Jawaban

No Jawaban No Jawaban
1 12J6-24 6 4
1
2 — 7 -3<x<1
8
56
3 90 8 —
3
-6 -5 9
4 9 Z
57 :
5 (g h ij 10 ﬁﬂ satuan volume
3'3°3 15
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Dynamic Geometry Software 1

A. Tujuan

Melalui aktivitas pada kegiatan pembelajaran 1, peserta diharapkan dapat
mengenal Wingeom serta menu-menunya untuk pembelajaran geometri 2

dimensi, khususnya garis dan sudut.
B. Indikator Pencapaian Kompetensi
Setelah peserta menyelesaikan kegiatan pembelajaran 1, peserta mampu:

1. Menjalankan Wingeom
2. Melukis garis dan hubungan antargaris serta menggunakannya untuk
aktivitas pembelajaran

3. Melukis sudut dan dan menggunakannya untuk aktivitas pembelajaran
C. Uraian Materi
1. Dynamic Geometry Software (DGS)

Dynamic Geometry Software (DGS) adalah program komputer yang bisa
digunakan untuk mengonstruksi objek geometri secara interaktif. Program
DGS biasanya mempunyai fitur pembuatan objek-objek geometri seperti titik,
garis, bangun datar, bangun ruang, dan semacamnya. DGS juga memuat fitur
yang mampu digunakan untuk membuat relasi keterhubungan antar objek-
objek geometri. Dalam suatu konstruksi geometri yang saling terhubung,
pengguna dapat menggerakkan suatu objek geometri dan program akan
secara otomatis menggerakkan objek-objek geometri lain menurut
batasan/relasi yang telah didefinisikan pengguna ketika mengonstruksinya.
Interaktivitas dan kemudahan untuk dimanipulasi semacam inilah yang
menjadikan DGS mempunyai potensi yang bagus untuk dimanfaatkan dalam

pembelajaran di kelas.
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Salah satu program interaktif geometri yang popular adalah GeoGebra. Selain
GeoGebra, terdapat banyak program software DGS, baik yang gratis maupun
berbayar antara lain: C.a.R., CaRMetal, Cinderella, EuklidDynaGeo, Eukleides,
Dr Genius, Dr. Geo, Gambol, GCLC, GeoKone.NET, Geolog, Geometry
Expressions, The Geometer's Sketchpad, Geometrix, Geonext, The Geometric
Supposer, Géoplan-Géospace, GeoProof, GEUP, GRACE, iGeom, Jeometry,
Isard, Kig, Kgeo, KmPlot, KSEG, Non-Euclid, OpenEuclide, Sphaerica, Live
Geometry, TracenPoche, Tabula, Tabulae, Archimedes Geo3D, Cabri, Euler,
Geometria, Geomview, GEUP 3D, PyGeo, JavaView, SingSurf, Sterizium,
Vectory, serta Wingeom. Modul ini akan secara khusus membahas tentang

Wingeom.
2. Wingeom
Memulai Wingeom

Wingeom dikembangkan oleh seorang tenaga pengajar di Philips Exeter

Academy di New Hampshire bernama Dr. Richard Parris. Wingeom dapat

diunduh secara gratis di website http://math.exeter.edu/rparris/

Wingeom.html. Tampilan website tersebut seperti di bawah ini. Anda dapat

mengunduh Wingeom dengan cara meng-klik ikon Wingeom di kiri atas

seperti pada gambar.
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« C [ math exeter edurpams’ [
I Apps ot Bookmaks [ DRatPTP [} Overview of learing st 7] Signinto Office 355 £3 Dropbox - DRIRPTP gy NEW SCHOOLS INDU.

Kiik di sini lM) for Windows 95/98/ME/2K/XP/Vista/7

Chck the above link to download the program. (14 Jul 12)

Page last updated: 14 Jul 12

Wingeom 13 for hagh-precision geometnc constructions m both two and three dimensions. Drawangs can be hughlighted and ansmal
sample Bles show (12 Jul 10)

The on-lne help pages are kept current (14 July 12)

There 15 also some supplementary matenyl (tutonals and labs) avalable (6 May 12).

Ifthe program behaves strangely, there is a page of EAQ, which may help. If not, you can e-mad me at the address found m the §
One way to mnsert a Wingeom dsagram into a webpage is to create an SVG file.

For those who have had trouble finding a font that enables Greek letters and other special symbols, try the MS LineDraw font.

Chck here for additional program information and history. (24 Jul 09)

Di website ini Anda dapat juga mengunduh manual, suplemen, atau contoh
file gambar yang telah dibuat oleh pengguna Wingeom. Dari hasil
mengunduh, Anda akan mendapatkan sebuah file dalam bentuk zip. Buka
saja file tersebut dengan double-klik maka akan muncul kotak persetujuan
untuk meng-unzip file. Klik saja di tombol unzip, maka file akan diekstrak ke
C: peanut. Di folder peanut tersebut terdapat file berekstensi application
untuk menjalankan Wingeom. Untuk memulai Wingeom Anda tinggal

melakukan double-klik di file Wingeom pada folder peanut tersebut.
Area Kerja Wingeom

Setiap menjalankan Wingeom, maka akan muncul kotak dialog berisi tips
seperti pada gambar di bawah ini. Tips ini berisi beberapa hal untuk

memandu Anda memanfaatkan fitur-fitur Wingeom.
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did you know that ...

A, writtern summary of all the steps that
produced the current diagram can be
fovnd in the Other | Lists | Histary best
window. cloze

next

Iv zhow a tip at startup previols

Anda dapat menuntupnya dengan memencet tombol Close. Apabila Anda
tidak menginginkan kotak dialog ini muncul setiap kali Anda menjalankan
Wingeom, Anda dapat menghilangkannya dengan mencentang di bagian

show a tip at startup.

Memunculkan kotak kerja dilakukan dengan mengklik window. Anda dapat
memilih kotak kerja apa yang Anda inginkan. Urut dari posisi atas, tersedia
kotak kerja untuk bangun datar dua dimensi dan tiga dimensi. Anda juga

dapat bekerja di permukaan lengkung seperti di hiperbola dan permukaan

bola.

Window  Help
2-dinn Fz
3-dim F3

Hyperbolic
Spherical

Woronoi

Guess

Tesselations ¥
REE demo

Cpen last
v Use defaults

Exit
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Untuk saat ini kita akan bekerja dengan menggunakan kertas kerja dua
dimensi. Setelah Anda klik di 2-dim akan muncul jendela seperti gambar di

bawabh ini.

Fil: Paoint Line  Circle  Uriks Btns  Wiew Other Help menu bar

Jendelaftempat

gambar

Penjelasan untuk menu bar

Seperti lazimnya suatu software program, menu File berisi menu-menu
untuk mengatur file seperti open, new, save, print, format dan semacamnya

termasuk help. Pada menu bar File terdapat tool-tool sebagai berikut.

-
A noname7 E@g

File | Point Line Circle Units Transf Edit Meas Btns View Anim Other

Mew Ctrl+M
Open ... Ctrl+0Q
Save Ctrl+5
Save As ... Ctrl+5hift+5
Print ... Ctrl+P
Format ... Ctrl+Shift+P

Select printer ...

Copy to clipboard

With back color

High resolution

Export graphics »

Image size ...

Bitmap to clipboard

Password ...

Author ...

Help
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- New, untuk membuat file baru

| File | Point Line Circle Units Transf Edit Meas Btns  View Anim  Other

New Ctri+M
! Open ... Ctrl+0O
Save Ctrl+5
Save As .. Ctrl+Shift+5

Print ... Ctrl+P

Format ... Ctrl+Shift+P
Select printer ...

Copy to clipboard
With back color
High resolution

Export graphics

Image size ...

Bitmap to clipboard

Open, untuk membuka file lama yang sudah pernah dibuat

Line Circle Units Transf Edit Meas Btns View Anim  Other

Lok in: Documents j = £ Ef-

|/ 9des13 | Corel User Files
2015 | Deadly Stars
| AdobeStockPhotos | Fax

| Beach Head 2002 | FILEM

| Buku Guru | foto jamsastek
| Camera_Cyberlink_1.0.1306_W7:86W7:64_4 || gbr sejarah 13

4 [
File name:

Files of type: | Euciidean files ("WG2)
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- Save, untuk menyimpan file

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other

Sa\rein:l_ Documents j - I'j{ '

i 9des13 | Corel User Files
L2015 . Deadly Stars
| AdobeStockPhotos M Fax

|\ Beach Head 2002 L FILEM

| Buku Guru | foto jamsostek
|, Camera_Cyberlink_1.0.1306_WT:B6W7x64_A | gbr sejarah 13

]
File name:

Save as type: I Euclidean files (* WG2)

Point Line Circle Units Transf Edit Meas Btns View Anim  Other

Savein: I E My Documents L I‘j‘ -v

Mame Date modified

1 9des13 1271172013 2:18 AM
L2015 5/4/2015 5:04 AM

| AdobeStockPhotos 10/24/2015 3:31 PM

| Beach Head 2002 9/9/2012 9:03 AM

| Buku Guru 1014/201312:32.. -
<

File name: oname |

Save as type: IEudidean files (" WG2) ;I
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Print, untuk mencetak

le Point
Help

File Point

Help

Line Circle Units Transf Edit Meas Btns View Anim  Other

[ Prirt to file

— Print range
o Al

" Pages  fram: I b I

© Selection

Copies

Number of copies: |1 =
@ [T Callate

Line Circle Units Transf Edit Meas Btns View Anim  Other

@ width I?.E2

= wunit ID.SS

offzet of upper left corner
hori |2.54 wert |2.54

[ frame image

[ color printer
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- Select printer, untuk memilih printer

Help

I\ﬂrtual Bin

Margins fnches)
Left: 1 Right: |1
Top: 1 Bottom: |1

T e

- Copy to clipboard, untuk menyalin gambar pada aplikasi/jendela lain.

- Image size, untuk mengubah ukuran pixel

Help

width I

height [11.5

ok I cancel |
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- Password, untuk mengunci akses terhadap gambar yang dibuat.

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other
Help

pazaword

confirm

pratect savediename W
histom - notebook [

show copyright data [

author
date

e-mail

homepage

=

Menu Point

Pada menu bar selanjutnya terdapat menu Point. Sesuai namanya, di menu

Point berisi menu-menu terkait titik yang akan kita buat.

window  Help

A nonamel

File Point Line Circle Uniks  Transh Edit

[m—
Mew

oL A nonamel
Point  Line Circle  Units Tr
on Segment ...
on Circle ..
in Triangle ...
on Palygon ...

Coordinates ...
Inktersection
Random paink
Special

Paste coordinates

Help
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On segment, digunakan untuk membuat/menentukan titik pada garis.
Apabila akan dilukis titik C tepat di tengah-tengah AB, dapat dilakukan

dengan memasukkan nilai %2 pada kolom coordinate.

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other
Help

relative to zegment IAB

coordinate |1 i2

left=0 ¢ coordinate < 1 =rnght

mark. I undo | close |

On circle, digunakan untuk menentukan titik pada lingkaran. Apabila akan
dilukis titik C dengan besar sudut CAB 60°, maka di kolom coordinate
diisi 60°.
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[ 4 nonamez . e e |
File Point Line Circle Units Transf Edit Meas Btns VYiew Anim Other
Help

center-pt IAB

coordinate IBU.EI
paint =0 < coordinate [degrees)

mark | undo cloze

- On triangle, digunakan untuk menentukan titik dalam suatu segitiga yang

telah dibuat sebelumnya.

A noname?

File  Point Line  Circlel Units. Transf Edit Meas Btns  Yiew Anim| Other Help

new point

relative to ABC = I.-’-'«BE

/3 times AB
143 times AC

mark, I undo | cloze |
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- On Polygon, digunakan untuk menentukan titik pada segi banyak

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other
Help

" movable with mouse

o coordinateIU.?2
mark. I undo I close |

- Coordinates, untuk menentukan koordinat suatu titik. Setelah mengisi
absis dan ordinat yang diinginkan, kemudian tekan mark. Sumbu

koordinat akan otomatis muncul.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other
Help
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- Intersection, untuk menentukan titik perpotongan dua garis yang telah

dibuat/didefinisikan sebelumnya.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

line: |AR
line [CO|

rnark | undo | close |

- Random point, untuk menentukan sebarang titik (oleh komputer).

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

—ICEHCE‘

- Special, untuk menentukan titik-titik khusus, seperti circumcenter atau

incenter dari sebuah segitiga.
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o

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help

cancel

cancel

Line
Menu Point berisi submenu terkait dengan melukis garis.

b T ke
File Point |Line| Circle Units Transf Edit Meas Btns View Anim Other
Help Segments ...

Lines ...
Parallels ...
Angles
Perpendiculars
Tangents
Equation ...
Vector sum ...

Extensions ...

Help
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- Segments, digunakan untuk membuat garis dengan menghubungkan dua

buah titik.

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help

make a list

ok I cancel

- Lines, digunakan untuk membuat garis yang melalui dua titik.

Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

make alist

ok I cancel
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- Rays, digunakan untuk membuat sinar garis.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

make a lizt

ok I cancel

- Parallels, untuk membuat garis paralel.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

parallel ta I>¢<
through paint IA

draw I unda | cloze |
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- Angles, untuk membuat garis yang membentuk sudut tertentu dari sebuah

garis.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

initial 12y B

angle size IEU.U

draw I undo | close I

- Perpendicular, untuk membuat garis yang tegak lurus dari suatu garis.

Point  Line Circle Units Transf Edit Meas Btns View Anim  Other Help

perp ta line |AR
from point |C

undo close
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- Tangent, digunakan untuk melukis garis singgung

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

- Equation, digunakan untuk melukis garis dengan memasukkan

persamaan garisnya.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

® arby=c O p=kempeh) O fy]=(hkl+tak]
a= 10

color

b= |20 draw

c=[50

undo

cloge

Extension, digunakan untuk memperpanjang garis.
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Meas
Meas digunakan untuk mengukur entitas geometri yang sudah dibuat.

Sebagai contoh ketikkan AB untuk mengukur panjang garis AB, ketikkan
<ABC untuk mengukur sudut ABC, dan ketikkan ABCDE untuk mengukur luas
bangun ABCDE. Untuk mengukur keliling suatu bangun, misalnya bangun

ABCD, dapat dilakukan dengan mengetikkan AB+BC+CD+DA.

Anda dapat menemukan cara-cara memasukkan perintah untuk mengukur

beberapa hal dengan mengklik help.
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A noname2 - 0O X

File' Point Line Circlel Units| Transf Edit Meas  Bitns| Wiew  Anim Cther Help

measurements

[2]

deletel displa_l,ll f-:-rmulal copy | help |

Fl=pi FZ=tt F3i=2q Fh=phi

Btns
Menu Btns ini digunakan untuk perintah yang cepat.

- Segments, untuk menghubungkan titik-titik. Klik kiri titik kemudian

kursor didrag sampai ke titik yang lain.

Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

% zegments
" rays

oo
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- Rays, untuk membuat sinar garis yang dimulai dari satu titik (misalnya A)

dan melalui titik yang lain.

Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

toolbar
 seqments
& raps

- Lines, untuk membuat garis yang melalui dua titik.

Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

toolbar

" segments
" raps
* lines

- Circles, untuk membuat lingkaran. Klik kiri pada suatu titik (misalnya
titik A) sebagai titik pusatnya kemudian drag kursor sesuai dengan

ukuran jari-jari linhgkaran yang diinginkan.
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ne Circle Units Transf Edit Meas Btns View Anim Other

Help

toolbar

. segrents

 rays
 lines

% cicles

- Drag vertices, untuk merubah lokasi titik.

t Line Circle Units Transf Edit Meas Btns View Anim Other

toolbar

Help

e Tie e T

ol

segments
rays
lires

circles

drag vertices
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- Text.
Kadang-kadang diperlukan keterangan untuk obyek yang telah dibuat,
untuk menambahkan keterangan berupa teks dapat memanfaatkan

fasilitas Text.

P
File Pork Lne Orde Unts Tramd Edt Mest Btre Yiew Anm Other Help

Edit

Di dalam menu edit terdapat submenu yang sering kali diperlukan ketika
melukis obyek geometri. Sebagai contoh akan ditambahkan tanda sudut di
sudut C dari segitiga ABC. Untuk menambahkan salah satu sudut segitiga
ini digunakan fasilitas Edit = Highlights > markings.
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A noname? i\

File' Point Line  Circle Units Transf Edit Meas  Btns  View  &nim| Other Help

markings

angle arc at BCL

< w ]
where I colar |

type nunnber 1el size

Ianglearc LI |1 ;I |1-DLI
mark. I delete onel delete all I cloze |

Fasilitas lain pada menu Edit adalah fasilitas untuk mengarsir. Mengarsir
suatu bidang dapat dialakukan dengan mengklik submenu Highlights - Fill
regions. Ketikkan bidang yang akan diarsir di kolom polygon, misalnya

bidang ABC.
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£ noname?

File Point Line Circle Units  Transf Edit Meas Btns  Miew Anim Other  Help

color | patteml hor gtripes

* pol_l,lgu:unl
7 curve I

fill | ingert " before O after selection

polygon AEC with hor stripes rob(:

3 T

delete ane | delete all |
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D. Aktivitas
Aktivitas 1 : Membuat titik.

Titik dapat dibuat dengan cara klik kanan. Wingeom menamai secara

otomatis titik yang dibuat.

v

Window Help

File Point Line Circle Units Transf Edit Meas Btns View
Help

E. Latihan

1. Lukislah sudut-sudut yang saling bertolak belakang. Dengan
memanfaatkan menu Meas, gunakan untuk menunjukkan (konfirmasi)
bahwa sudut yang saling bertolak belakang sama besar.

2. Apabila terdapat dua garis sejajar dipotong oleh sebuah garis yang lain,
maka akan terbentuk sudut-sudut yang sehadap, sepihak, maupun
bereseberangan. Buatlah gambar kondisi ini dan tunjukkan hubungan

antar sudutnya.
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Dynamic Geometry Software 2

A. Tujuan

Melalui kegiatan pembelajaran 2 ini peserta diharapkan dapat mengenal
serta mengggunakan menu-menu Wingeom untuk pembelajaran geometri 2

dimensi, khususnya bangun datar.
B. Indikator Pencapaian Kompetensi

Setelah peserta menyelesaikan pembelajaran ini peserta dapat menggunakan

Wingeom untuk membuat bangun datar.
C. Uraian Materi

Pada kegiatan belajar sebelumnya telah dipelajari beberapa menu terkait
titik, garis, dan sudut. Pada kegiatan pembelajaran ini akan dipelajari menu-

menu terkait bangun datar.
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Menu Circle

Melukis lingkaran dapat dilakukan dengan memanfaatkan menu Circle.

A s =

File Point Line Units Transf Edit Meaz Btns View Anim  Other

Help Circurncircle ...

Incircle ...
Radius-center ...
Apollonian ..
Poincaré ...

Excircle ...
Mine-point circle ...
Tangent circles ...
Soddy circles
Equation ...

Help

Melukis lingkaran dapat dilakukan dengan beberapa cara. Cara pertama
adalah melukis lingkaran dengan menentukan titik pusat dan radiusnya.
Silakan coba mengeksplorasi cara-cara melukis lingkaran yang lain, dengan
mencoba.

A noname? = (=

Filel Point) Line Circle Units Transf Edit Meas| Btns Wiew  Anim| Other. Help

draw circle or arc

centered at I.f-\

circle through I
circle radius |4

arc starting at I.t'-\
ending at I— CCL

angular size I'I 20.00

draw | unda | cloge |
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- Circumcircle, digunakan untuk melukis lingkaran yang melalui tiga titik.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

- Incircle, digunakan untuk membuat lingkaran dalam suatu segitiga

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

- Radius-center, digunakan untuk membuat lingkaran atau busur lingkaran

dari suatu lingkaran yang diketahui titik pusatnya
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File Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help

centered at |4

€ circle thiough
@ Gircle radius [1.00

arc starting at [A
©oendngat | oo
€ angular size [12000

undlo chose

- Poincare, digunakan untuk melukis busur lingkaran dari suatu lingkaran
yang melewati dua titik tertentu.

- Apollonian. Apabila diberikan titik A dan B, tool Apollonian ini digunakan
untuk melukis lingkaran yang memenuhi CA : CB selalu konstan. Dengan C

adalah sebarang titik di lingkaran.

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help
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- Exircle, digunakan untuk melukis lingkaran luar segitiga.

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help

list triangles

ok I cancel

- Nine point, digunakan untuk melukis lingkaran yang melalui Sembilan titik

signifikan yang berhubungan dengan suatu segitiga.

File Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help

—IEEHEE‘
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- Equation, digunakan untuk melukis lingkaran dengan cara menuliskan

persamaan lingkarannya.

Edit Meas Btns View Anim Other Help

" centerradius % e+ +rax+bp=c
a= |00
b= |00
e= 10

draw I unda | colar | cloge |

- Tangent circle, digunakan untuk melukis tiga lingkaran yang masing-
masing berpusat di titik berbeda dan ketiga lingkaran tersebut saling

bersinggungan.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

=N

121



Kegiatan Pembelajaran 5

- Soddy circle, digunakan untuk melukis Lingkaran Soddy. Lingkaran
Soddy yaitu suatu lingkaran yang menyingung tiga buah lingkaran yang

saling bersinggungan.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

select thiee paiiwise tangent circles

center A; through D
center B; through E
center C; through F
center G; through H
center K; through L

diaw undo
Coer |

Units

Menu Units dapat digunakan untuk melukis bangun datar, seperti segitiga,

segi banyak, dan ellips.

A mnanel}__

Triangle
Polygon
Random
Segment ...
Grid ...

Conics

Array of circles
Duplicate ...

Help

- Triangles, digunakan untuk melukis segitiga. Segitiga dilukis dengan

menginput ketiga sisinya atau sisi dan sudutnya.
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angle I
side |5.D
angle IEEI. o

cace |

- Polygons, digunakan untuk melukis bangun segi banyak. Anda diminta
menginput beberapa unsur dari segi banyak yang akan dilukis, seperti

banyak sisi dan panjang sisinya.

sides I?
length of side I'I 0

ok, I cancel |

Pada submenu Polygons ini terdapat juga fasilitas untuk membuat bangun
datar yang sisinya bersekutu dengan bangun datar lain yang sudah dibuat.

Untuk membuatnya diigunakan Units = Polygons - Attach.
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A noname? |

File! Poink Line Circlel Uniks Transf Edit Meas  Btns Wiew| Anim Other Help

reqular palygar with |4 sides
bo edgelz] IB.t'-\

attach I undo | close |

Anda dapat juga menambahkan persegi atau bangun datar segi banyak

lainnya di sisi AC dan BC.

Random, digunakan untuk melukis segi banyak. Komputer akan

melukiskannya secara otomatis.

Point Line Circle Units Transf Edit Meas Btns View Anim  Other Help
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- Segment, digunakan untuk melukis garis. Anda diminta untuk

memasukkan panjang garis dan sudutnya terhadap sumbu x positif.

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

- Grid, digunakan untuk membuat grid (kisi-kisi).

File Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

widh [
height |5E|—
angle IUU—
hori dats l?—
wert dots IS—

==

- Conic, digunakan untuk membuat irisan kerucut (bangun sisi lengkung),

seperti ellips.

Point Line Circle Units Transf Edit Meas Btns View Anim Other Help

IAB foci

& eccentriciy ID.B

oo _ae | |

foci AB, eccentricity 0.6 [rgb(255,

S

mark point at coordinate ||1 .0

asymptotesl undol close |
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- Array of circles, digunakan untuk membuat lingkaran-lingkaran yang

saling bersinggungan.

Zle  Units Transf Edit Meas Btns View Anim  Other Help

T

clms

radiuz |1 .00
cancel |

- Duplicate, digunakan untuk menggandakan bentuk yang sudah dibuat.

int  Line Circle Units Transf Edit Meas Btns View Anim Other Help

ligt vertices IA-C
magnification |1 0

¥ rotate copy

copy I undo | cloge |
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D. Aktivitas
Aktivitas 1: Segitiga

Salah satu cara melukis segitiga adalah dengan klik menu Units > Triangle,
akan didapati tiga cara yaitu dengan mengisikan panjang ketiga sisinya, dua

sisi dan satu sudut yang diapit sisi, serta dua sudut dan satu sisinya.

Lukislah segitiga dengan panjang sisi 3, 4, dan 5, dengan cara memilih

submenu SSS.

Dari segitiga yang sudah dibuat ini dapat garis tingginya. Untuk melukis garis
tinggi dilakukan dengan klik Line >Perpendicular - Altitude.

A noname? - O

File Point Line Circle Units  Transf  Edit Meas Btns VWiew Anim  Other  Help

draw altitude

perp to line |AC
from paint  |B

draw ‘ unda | close |

Anda juga dapat menambahkan lingkaran dalam segitiga dengan
menggunakan menu Circle = Incircle. Menu Line = Segment dapat
digunakan untuk melukis ruas garis yang menghubungkan titik-titik yang ada

di gambar yang telah dibuat.
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A noname? - 0O X

make a list

ok | cancel

Aktivitas 2 : Lingkaran

Untuk melukis lingkaran digunakan menu Circle. Salah satu caranya adalah
dengan memilih titik pusat dan menentukan panjang jari-jarinya. Misalkan
akan dilukis lingkaran dengan pusat A dan jari-jari 4. Untuk melukis
lingkaran dengan cara ini, Anda sudah harus melukis titik A terlebih dahulu.
Apabila belum lukislah titik A dengn cara klik kanan pada lembar kerja,
pastikan pada menu Btns diaktifkan submenu segment. Lingkaran juga dapat
dilukis dengan klik pada titik pusat (titik A), dan didrag sesuai dengan

panjang jari-jari yang diinginkan.

Dari lingkaran yang sudah dibuat, dapat dilukis unsur-unsur lingkaran.
Misalnya akan dibuat busur BC dengan besar sudut pusat 60°. Busur BC
dibuat dengan cara klik Circle = Radius-Center kemudian masukkan besar

sudut 60° dengan busur dimulai dari B dan diakhiri di titik C.
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Latihan

. Lukislah sebarang segitiga beserta lingkaran dalamnya, kemudian
gunakan menu Meas untuk menunjukkan hubungan antara jari-jari
lingkaran dalam dengan luas dan keliling segitiga.

. Lukislah sebarang segitiga beserta lingkaran luarnya, kemudian gunakan
menu Meas untuk menunjukkan hubungan antara jari-jari lingkaran luar
dan luas segitiga.

. Lukislah sebarang lingkaran dan sembarang juring pada lingkaran
tersebut. Gunakan menu Meas untuk menunjukkan hubungan luas
juring, sudut pusat dengan luas lingkaran.

. Lukislah sebarang lingkaran dan sembarang busur lingkaran. Gunakan
menu Meas untuk menunjukkan hubungan sudut pusat dengan sudut
keliling lingkaran.

. Gunakan menu Meas untuk mengilustrasikan Teorema Pythagoras pada

segitiga siku-siku yang telah Anda lukis di Aktivitas 3.
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Dynamic Geometry Software 3

A. Tujuan

Melalui kegiatan pembelajaran 2 ini peserta diharapkan dapat mengenal
serta menggunakan menu-menu Wingeom untuk pembelajaran geometri 3

dimensi.
B. Indikator Pencapaian Kompetensi
Setelah peserta menyelesaikan pembelajaran ini peserta dapat:

1. melukis kubus dengan Wingeom
2. melukis diagonal ruang

3. melukis perpotongan garis dan bidang di dalam kubus
C. Uraian Materi

Pada kegiatan pembelajaran sebelumnya telah dipelajari penggunaan
Wingeom 2-dim. Pada kegiatan pembelajaran ini akan dibahas Wingeom 3-
dim. Ada 13 menu dalam jendela 3-dim, yang akan dibahas secara ringkas

berikut ini.
File
Menu file memuat beberapa sub menu yang terkait dengan pengolahan file

sama seperti pada jendela 2-dim. File Wingeom disimpan dengan ekstensi

wg3.
Point

- Coordinates (absolute), digunakan untuk menampilkan koordinat x, y, z
dan menyediakan fasilitas untuk membuat koordinat baru dengan

mengisi kotak edit x, y, z pada jendela dialog coordinates for new point.
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~— [3} Date & Time
b Object ~

File Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

coordinates for new point

= |03
v=|07
z= |04

& independently movable

" defined position
" same urit az poink IA

mark. | undo I cloge I

- 1 relative coordinate, digunakan untuk menggambar titik yang letaknya

relatif terhadap suatu ruas garis.

relative to segment IGH
coordinate I'I.-’Z

left =0 < coordinate < 1 =right

mark. | unda | cloze I
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2 relative coordinates, digunakan untuk menggambar titik yang letaknya

relatif terhadap dua ruas garis.

relative to ABC = IGHE

I tite:s AR

E

times AC

mark. | unda I close |

3 relative coordinates, digunakan untuk menggambar titik yang letaknya

relatif terhadap tiga ruas garis.
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relative to ABCD = IEFG H

{144 times 4B
{144 times AC
{144 times 4D

mark, | unda close

- on Circle, digunakan untuk menggambar titik pada suatu lingkaran pada

suatu bangun ruang dengan sudut tertentu pada koordinat sudut.
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disk (radius AC, perp to
disk (radius BD, perp to .

« 3
coordinate [degrees) |1 20
draw | undo I cloze |

- on Polygon, digunakan untuk menggambar suatu titik pada segi banyak

pada suatu bangun ruang dengan koordinat tertentu.

|CDE

o coordinate|1.?2
mark | undo | close I
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- Intersection of line and ...
e Plane, digunakan untuk menggambar titik potong antara garis
dengan bidang datar.
e curved surface, digunakan untuk menggambar titik potong antara
garis dengan bidang lengkung.
- Paste coordinates, digunakan untuk menempelkan coordinat dalam
clipboard ke dalam teks pada program pengolah kata yang lain.
- Latittude-longitude, digunakan untuk menampilkan titik dengan garis
bujur dan garis lintang pada koordinat bola.

- Help, digunakan untuk menampilkan informasi tentang menu point.

Linear

- Segment or face, digunakan untuk menggambar ruas garis atau bidang

sisi yang kita inginkan.
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make a list

|aG. CEl

—Icance‘

o

chiiliﬂ&lvuilhﬂsﬁzdﬁﬂlhasﬂns\fhﬁnﬂﬂu
Help

- Perpendiculars
¢ Point to Line, digunakan untuk menggambar garis tegak lurus dari

suatu titik ke suatu garis.
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File Point Linear Curved Units Transf Edit Meas Btns View Anim Other
Help

perp ta line |AR
from point - |H

draw undo close |

File Point Linear Curved Units Transf Edit Meas Btns View Anim  Other
Help

¢ Point to Plane, digunakan untuk menggambar garis tegak lurus dari
suatu titik ke suatu bidang.
¢ Plane Normal, digunakan untuk menggambar garis tegak lurus dari

suatu titik ke suatu bidang normal.
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plane ABC = IEDG

& BD length= [40

" BD = vector product BC x BA

ok I cancel I

- Vector Sum, digunakan untuk menggambar jumlahan dua vektor dengan

titik awal tertentu.

list vectors; base vertes

|EFFG:H

crei |

- Cutting plane, digunakan untuk menggambar hasil irisan suatu bidang

yang diberikan pada suatu bangun ruang .
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A
File Point Linear Curved Units Transf Edit Meas Btns View Anim
Other Help

verices [a.)

& by Bvertex plane [HIJ

by the plane thiough  [4

©* pependicular to [BC

© paaleltaAC and 4B

€ by the plane ansbyscz=d

10
20
30
d |40
™ discard side with vertex |1

I hide new labels hide new dats [~

File Point Linear Curved Units Transt Edit Meas Btns View Anim
Other  Help

- Help, menampilkan informasi tentang menu linear.

Curved

- Sphere
¢ Circumsphere, digunakan untuk menggambar bola luar dari titik-titik

tak sebidang.
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e inscribe in Tetrahedron, digunakan untuk menggambar bola dalam

suatu bidang banyak.

140




Modul Diklat Guru Pembelajar

e inscribe in Cone, digunakan untuk menggambar bola dalam suatu

kerucut.

Point  Linear Curved Units Transf Edit Meas Btns View Anim  Cther Help

¢ Dandelin, digunakan untuk menggambar bola dalam suatu kerucut

yang dipotong suatu bidang di mana bola menyentuh bidang potong.

e Radius-center, digunakan untuk menggambar bola dengan

memberikan titik pusat dan jari-jari.
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Curved Units Transf Edit Meas Btns View Anim Other Help

center IA

i radius IT 3
" north pole I

undo cloze |

¢ Segment, digunakan untuk menggambar bola dengan memberikan

titik pusat, kutub utara dan diameter.

urved  Units  Transf Edit Meas Btns View Anim Other Help

center A
north pale E|

height/diameter |0.5

Cancel
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e Latitude circle, menggambar bola dengan memberikan titik pusat,

kutub utara dan garis lintang.

wved Units Transf Edit Meas Btns View Anim Other Help

sphere center IA
north pole IB
latitude |43.D

drawe I undo | close |

¢ Meridian, digunakan untuk menggambar bola dengan memberikan
titik pusat, kutub utara dan garis bujur.
e Great circle, digunakan untuk menggambar bola dengan memberikan
titik pusat dan dua titik pada suatu bola.
e Tangent-point circle, digunakan untuk menggambar titik-titik
singgung garis-garis dengan bola yang
» Point-sphere, ditarik dari titik di luar bola
» Sphere-sphere, ditarik dari bola yang lainnya
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- Cone, digunakan untuk menggambar kerucut dengan memberikan pusat,

jari-jari dan titik yang dilalui

O S——————
File Point Linear Curved Units Transf Edit Meas Btns View

Other Help

- Frustum, digunakan untuk menggambar kerucut terpancung dengan

memberikan pusat, jari-jari dan titik yang dilalui.

File Point Linear Curved Units Transf Edit Meas Btns View Anim
Other  Help

lowser radius Im
height |3.DD
upper radius |1 a0

care |
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- Cylinder, digunakan untuk menggambar tabung dengan memberikan

pusat, jari-jari dan titik yang dilalui.

nnt  Linear Curved Units Transf Edit Meas Btns View Anim
Help

radiuzs I

height [2.00
ok I

- Disk, digunakan untuk menggambar daerah lingkaran. dengan

memberikan pusat, jari-jari dan titik yang dilalui.

Point Linear Curved Units Transf Edit Meas Btns View Anim
Help
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- Intersection, digunakan untuk menggambar perpotongan bola dengan
bola atau bola dengan kerucut.

- Help, digunakan untuk menampilkan informasi tentang menu curved.

Unit

- Polyhedral, digunakan untuk memvisualisasikan macam-macam bangun
ruang bidang datar.
e C(lassics, menggambar bangun-bangun teratur termasuk bangun ruang

Platonic dan bangun ruang Archimedean.

Foint  Linear Lurved Urnits  Iranst  kdit  Meas Btns  View  Amm

ier  Help

' Platonic tetrahedron

" Archimedean regular hexahedron (cube)

‘® Kepler-Painsot regular octahedron
regular dodecahedron

€ Johnson catalog regular icosahedron

< o] r
edge Iength|1.DD I~ center |F

build I undo | close |

 mizcelany

[ al faces same  colar |

e Prism, digunakan untuk menggambar Prisma, dengan jumlah sisi alas,

panjang sisi dan tinggi.
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Point Linear Curved Units Transf Edit Meas Btns View Anim
=r  Help

rumber of sides I? <25

length |1 0o
height IZ.DD

bwild I undo | cloze I

e Pyramid, digunakan untuk menggambar Limas, dengan jumlah sisi

alas, panjang sisi dan tinggi.

sint  Linear Curved Units Transf Edit Meas Btns View Anim
Help

number of sides I? <25
length |1 oo

& alitude ¢ edgeht ¢ face ht

2.00
build I undao | close |

e Antiprism, digunakan untuk menggambar AntiPrisma, yaitu seperti
prisma tetapi sisi alas dan sisi atas bersilangan, dengan jumlah sisi

alas, panjang sisi dan tinggi.
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int  Linear Curved Units Transf Edit Meas Btns View

Help

baze edges I? <25
length |1.DD
height |2. 1]

undo | close |

e Box, digunakan untuk menggambar Balok, dengan memberikan

panjang sisi-sisinya.

Linear Curved Units Transf Edit Meas Btns
2

length Im
width |2.D
height IB.U

ok I cancel |

e Spherical, digunakan untuk menggambar pendekatan bola dengan

menggunakan bangun datar.
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int  Linear Curved Units Transf Edit Meas Btns View Anim
Help

levels I‘I 2 drawy
sectors |2D undo
radius I'I.D close

e Tetrahedron, digunakan untuk menggambar bidang empat dengan

memberikan alas dan sisi.

it Linear Curved Units Transf Edit Meas Btns View Anim
lelp

e Pyramid of cubes, digunakan untuk menggambar bentuk piramid dari

sejumlah kubus dengan tingkat tertentu.
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Point Linear Curved Units Transf Edit Meas Btns View

r Help

layers

cube edge |1.UU
caesl |

e Vertex type, digunakan untuk menggambar bidang banyak dengan

mendefinisikan banyaknya bidang dan sisi yang bertemu.

Point Linear Curved Units Transf Edit Meas Btns View Anim
r Help

incident faces I

rumber of gides per face

face 1 |3_
face 2 |3_
face 3 |3—
face 4 |3—
face 5 |3—

length I'I 0o
cancel |

150




Modul Diklat Guru Pembelajar

¢ Random, digunakan untuk menggambar bangun ruang sembarang
untuk

= Prism, prisma

Linear Curved Units Transf Edit Meas Bitns View Anim

rumber of sides I? <25

bazes: & regular © cpclic ¢ convex

build I unido | cloze

= Pyramid, limas

Linear Curved Units Transf Edit Meas Btns  View Anim
o

riumber of sides I? <25

bases: @ regular O cyclic O conves

bwild I undo | cloze

= Tetrahedron, bidang empat

151




Kegiatan Pembelajaran 6

- Surface, digunakan untuk memvisualisasikan bangun ruang bidang
lengkung.

e Cylinder, menggambar tabung dengan memberikan jari-jari dan tinggi.

Jpint Linear Curved Units Transf Edit Meas Btns View
Help

152




Modul Diklat Guru Pembelajar

¢ Cone, menggambar kerucut dengan memberikan jari-jari dan tinggi.

Linear Curved Units Transf Edit Meas Btns  View

Ip

e Frustum, menggambar kerucut terpancung dengan memberikan jari-

jari atas, bawah dan tinggi.

Linear Curved Units Transf Edit Meas Btns View £
}
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e Sphere, menggambar bola dengan memberikan jari-jari.

¢ Hemisphere, menggambar setengah bola dengan memberikan jari-jari.

it Linear Curved Units Transf Edit Meas Btns View Anin
lelp

e Array of Sphere, digunakan untuk menggambar suatu susunan bola
= Square pyramid, menggambar susunan bola dengan bentuk

piramid persegi dengan tingkat tertentu.

‘eint  Linear Curved Units Transf Edit Meas Btns View Anim
Help

layers IE
radiuz I‘I oo

carce |

= Triangular pyramid, digunakan untuk menggambar susunan bola

dengan bentuk piramid segitiga dengan tingkat tertentu.
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t Linear Curved Units Transf Edit Meas Btns  View Anim
zlp

layers IE
radiug |1 .an

ok I cancel |

= Cube, digunakan untuk menggambar susunan bola dengan bentuk

kubis dengan tingkat tertentu

Linear Curved Units Transf Edit Meas Btns View Anim
p

layers IE

radius [1.00

ok I cancel |

e Disk, digunakan untuk menggambar daerah lingkaran. dengan

memberikan pusat, jari-jari dan titik yang dilalui
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t Linear Curved Units Transf Edit Meas Btns View Ar
zlp

- Duplicate, menduplikat suatu bangun ruang yang telah dibuat.
- Attach copy, mengcopy suatu bangun ruang yang dibuat.

- Help, menampilkan informasi tentang menu unit.

Transf

- Translate, digunakan untuk menggambar bayangan suatu bangun ruang.

File Point Linear Curved Units Transf Edit Meas Btns View Anim
Other  Help

vertices I
by the multiple |1.U

of wectar IAE

caen |
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- Rotate, digunakan untuk memutar bangun ruang dengan sumbu putar

tertentu dan besar sudut tertentu.

wear Curved Units Transf Edit Meas Btns  View Anim

vertices I

angle  [720

around axiz |AE

& huo-vertex vector
" through circumeenter of perp tiangle
from circumcenter of four wertices to

¢ midpaint of first bwo vertices

© firgt vertex

ces |

- Dilatate, digunakan untuk menggambar dilatasi pada suatu bangun

ruang.

Point Linear Curved Units Transf Edit Meas Btns View Anim
r Help

vertices Im

center IEI'

factor ID.ED

G |

- Last repeat, digunakan untuk mengulang perintah transformasi terakhir

yang dilakukan pada suatu bangun.
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- Mirror, digunakan untuk menggambar pencerminan pada suatu bangun

ruang

sint  Linear Curved Units  Transf Edit Meas Btns  View Anim

Help

vertices |A-D

& by Ivertex plane I.&BC

by the plane through I.t‘-‘«
" pependicular to IBC
= parallel to I.-’-‘«C and IAE

by the plane as+by+cz=d
a |10
b |20
c |30
d |40

- Normal translate, digunakan untuk melukis hasil pergeseran dari suatu

bangun ruang.

zar Curved Units Transf Edit Meas Btns View Anim

vertices I
away from plane IAEE

distance |'| A

cve |

- Save labels, menyimpan label supaya tidak berubah.
- Atribute copy

- Help, Menampilkan informasi tentang menu transf.




Modul Diklat Guru Pembelajar

Edit

- Undo, Membatalkan pekerjaan yang baru saja dilakukan.

- Redo, Menampilkan kembali pekerjaan yang baru saja dibatalkan.

- Linear elements, Memuat beberapa sub menu pengeditan pada garis dan
bidang sisi.

it Linear Curved Units Transf Edit Meas Bins View Anim
elp

edit linear items

ooz, comHe

add | [ delete |

El

undo |

labels |

calor |

transp |

subdivizion certral mhpﬂntl
ot cloge |

&

- Curved elements, Memuat beberapa sub menu pengeditan pada garis

lengkung dan bidang lengkung.
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edit curves and surfaces -

cylindel adiu
disk [radiuz AC. perp to AB)
dizk [radius BD, perp to BA)

< 3

pen color | fill zolor | transparent |

labels on/off I delete | undelete |
close |
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- Coordinates, Meng-edit titik koordinat.

File Point Linear Curved Units Transf Edit Mess Btns View Anim
Other Help

File Point Linear Curved Units Transt Edit Meas Btns View Anim
Other Help

x= [p.75460

v= [z00000

2= [6.00000

[l = B
setl | &y ©y ¢z satR

close

- Point delete, Menghapus titik yang telah dibuat.
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ar  Curved Units Transf Edit Meas Btns View Anim

File Point Linear Curved Units Transf Edit Meas Btns View Anim
Other  Help

- Text delete, Menghapus teks yang telah dibuat.
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File Point Linear Curved Units Transf Edit Meas Bitns View Anim
Other Help

delete all text?

e

File Point Linear Curved Units Transf Edit Meas Btns View Anim
Other Help

- All faces delete, Menghapus semua sisi yang telah dibuat.

File Point Linesr Curved Units Trans File Point Linear Curved Units Transt Edit Mess Bins View Anim
Other  Hel
itz ap Undo CtriZ S E

Redo Chrl+¥

Linear elements ...
Curved elements ...
Coordinates ...

Header ...
Decimal places ...
Functions ...
Macro

Import
Randomize

Help

- Header, Mengedit judul history.
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- Decimal places, Mengedit tempat desimal pada menu measurement.

- Function, Mengedit tampilan fungsi yang telah kita buat.

- Macro, Serangkaian instruksi dalam history dari suatu bangun, yang
dapat diterapkan untuk bangun yang lain
¢ Define, Mendefinisikan macro

¢ Open macro window, Membuka jendela macro

Apply, Menggunakan macro

Undo, Membatalkan macro

Replay, Menjalankan kembali macro
- Randomize Menampilakan gambar baru secara acak.

- Help Menampilkan informasi tentang menu edit.

Measurement

- Menu measurement digunakan untuk mencantumkan ukuran-ukuran
tertentu yang dapat ditampilkan pada obyek geometri.
Btns

- Slide point, Meng-edit koordinat.

- Text, Menampilkan jendela untuk membuat teks.

- Paste clipboard, Menempelkan suatu copy-an clipboard
- XYZ cords, Menampilkan titik-titik koordinat.

- Toolbar, Memunculkan jendela toolbar

- Help, Menampilkan informasi tentang menu Btns

View
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- Display, Mengatur mode tampilan bangun ruang

e Painted, sisi tampil tertutup dan dapat diwarnai

sint Linear Curved Units Transf Edit Meas Bins Anim_ Other Help
Display v Painted
|V | Convesity assumed Painted and dotted

— N Ray-traced
Rotate »| ¥ Dot hidden lines
Observer v Show hidden lines

¥ | Outlines

File Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Painted and dotted, Sisi tampil tertutup dan rusuk yang tidak

kelihatan tampil sebagai garis putus-putus
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—
File Peint Linear Curved Units Transf Edit Meas Btns Anim  Other Help

| Display v| v Painted
W Convexity assumed | Painted and dotted
N Zoom » Ray-traced
Rotate v Dot hidden lines
Observer v Show hidden lines
/ Restore Ctrl+W ‘7‘ P
Last window -

Labels
Axes
Markings

Help

Point Linear Curved Units Transf Edit Meas Btns View Anim

e Ray-traced, Sisi tampil tertutup, dengan warna abu-abu, sisi yang

berada di depan diwarnai lebih gelap
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=
File Point Linear Curved Units Transf Edit Meas Btns Anim  Other Help

| Display » Painted
|V Convexity assumed V| Painted and dotted
Zoom y|  Reytraced
Rotate r Dot hidden lines
Observer , Show hidden lines
Lo Restore Ctrl+W V| outtines

Last window

Labels
Axes
Markings

Help

Point Linear Curved Units Transf Edit Meas Btns View Anim  Other

e Dot hidden lines, Sisi tidak tampil, hanya tampil rangka bangun,

dengan rusuk yang tertutup sisi tampil sebagai garis putus-putus.
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File Point Linear Curved Units Transf Anim  Other Help

| v painted

Painted and dotted
N Ray-traced

3l Dot hidden lines
Observer > Show hidden lines

v Outlines

File Point Linear Curved Units Transf Edit Meas Btns View Anim

e Show hidden lines, Sisi tidak tampil, hanya tampil rangka bangun,

dengan rusuk tidak tertutup sehingga tampil sebagai garis tegas
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File Point Linear Curved Units Transf Edit Meas Bins Anim  Other Help

Display v\ v Painted

Convexity assumed Painted and dotted
. ., Raytraced

Rotate v\ Dothiddenlines

»| Show hidden lines

|V Outiines

Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Outlines, Pilihan rusuk akan ditampilkan secara tegas atau tidak

File Point Linear Curved Units Transf Edit Meas Bins Anim  Other Help

Display » | ¥ | Painted

Convexity assumed Painted and dotted
oo ,| Reytraced

Rotate »| Dot hiddenlines

Observer 2 Show hidden lines

v | Outlines

File Point Linear Curved Units Transf Edit Meas Btns View Anim
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- Convexity assumed, Pilihan untuk asumsi konveksitas sisi dari bangun
ruang.
- Zoom, Mengatur besar kecil gambar bangun

e Out, Memperbesar gambar bangun (PgDn)

= —
it Linear Curved Units Transf Edit Meas Bins

e In, Memperkecil gambar bangun (PgUp)

le Point Linear Curved Units Transf Edit Meas Btns View Anim  Other Hi

e Factor, Mengatur besar kecil gambar bangun dengan faktor dilatasi

tertentu
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- Rotate Memutar-mutar gambar bangun

e Up, Memutar gambar bangun ke bawah (pengamat ke atas)

Up arrow

Down arrow

Right arrow

Left arrow

¢ Down, Memutar gambar bangun ke atas (pengamat ke bawah)

Curved Units Transf Edit Meas Btns View Anim Other Help

e Turn, Memutar gambar bangun ke kanan

File Point Linear Curved Units Transf Edit Meas Btns View Anim Other Hel

e Back, Memutar gambar bangun ke kiri
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‘ile Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Angle, Memutar gambar bangun dengan sudut tertentu

- Observer, Mengatur penampilan gambar sesuai keinginan pengamat.

e In, Bagian depan gambar tampil lebih besar

ile Point Linear Curved Units Transf Edit Meas Btns

e Out, Bagian depan gambar tampil lebih kecil
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ile Point Linear Curved Units Transf Edit Meas Btns Anim  Other Help

Observer » In Ins

Restore Crl+W Out Del
Last window Far out Ctrl+Del
Isometric

Coordinates ...

urved Units Transf Edit Meas Btns View Anim Other Help

e Far out, Bagian depan gambar tampil lebih besar

File Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Isometric, Sisi-sisi bangun tampil dengan ukuran sebenarnya
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file Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Coordinate, Gambar diamati dari suatu titik dengan koordinat tertentu
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nt Linear Curved Units Transf Edit Meas Btns View Anim Other Help

FIE]
w |32.00000
z 1800000

apply close

le Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

- Restore, Menampilkan gambar sebelumnya.
- Last window, Mengembalikan jendela pada pengaturan sebelumnya

- Axes, Menampilkan pengaturan sumbu koordinat.
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e Axes, Menampilkan sumbu koordinat

File Point Linear Curved Units Transf Edit Meas Bins View Anim Other Help

e Color, Mewarnai sumbu koordinat

e Fix length, Mengatur panjang sumbu koordinat dengan panjang

tertentu
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5 =EE

File Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

yo|z927e1

z |297160

e Labels, Menampilkan label %, y, z, dari sumbu koordinat

File Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Arrows, Menampilkan tanda panah pada sumbu koordinat

ile Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help
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- Highlight segments, Memodifikasi ketebalan dan warna ruas garis.
- Help, Menampilkan informasi tentang menu View

Anim

- Menu Anim digunakan untuk menjalankan animasi yang telah dibuat.

Other

- List Menampilkan daftar unsur-unsur yang terdapat dalam bangun datar
yang telah kita buat antara lain titik-titik, ruas garis, lingkaran, langkah-
langkah pengerjaan dan membuat catatan.

¢ Point, menampilkan koordinat titik yang telah dibuat

le Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

File Edit Help Close
(0.00000,0.00000,0.00000) (unit 1)
(3.00000,0.00000,0.00000) (unit 1)
(3.00000,3.00000,0.00000) (unit 1)
(0.00000,3.00000,0.00000) (unit 1)
(0.00000,0.00000,3.00000) (unit 1)
(3.00000,0.00000,3.00000) (unit 1)
(3.00000,3.00000,3.00000) (unit 1)
(0.00000,3.00000,3.00000) (unit 1)

R
momED QW

e Faces, Menampilkan luasan-luasan yang telah dibuat

Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

e Surface, Menampilkan bidang lengkung yang telah dibuat
e History, Menampilkan keterangan tentang pengerjaan yang telah
dilakukan
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e Condense, Memadatkan file gambar yang sudah dibuat

¢ Notebook, Membuat catatan

ar Curved Units Transf Edit Meas Btns View Anim Other Help

- Fonts, Mengatur font yang ingin ditampilkan pada submenu berikut

e Measurements, Mengatur font untuk measurement

‘oint Linear Curved Units Transf Edit Meas Btns View Anim Other Help

DF Calligraphic Omai
DF Diversions LET =

[Westem -
This is an OpenType fort. This same fort wil bs used on bath your
printer and your screen

e ASCII values, Mengatur nilai ASCII untuk simbol-simbol tertentu

t Linear Curved Units Transf Edit Meas Btns View Anim Other Help

degres symbol
P 227

radical 251

exponent 2 203

goldenratio |23
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e Label on axes, Mengatur font untuk label pada sumbu koordinat

Linear Curved Units Transf Edit Meas Btns View Anim Other

Westem -

This is an Open Type fort. This same fort wil be used on both your
printer and your screen

e Tables and lists, Mengatur font untuk tables dan list

Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

Font style:
[Reguiar

DF Calligraphic Ornai
DF Diversions LET ~ ~

Westem -

This is an OpenType fort. This same font wil be used on bth your
printer and your screen

- Colors, Memilih warna yang kita inginkan pada submenu berikut

e Background, Memilih warna latar belakang

Point Linear Curved Units Transf Edit Meas Btns View Anim Other Help

background color
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¢ Dotted lines, Memilih warna untuk garis putus-putus

e Color them, (tidak ada keterangan)

e White face, Mewarnai setiap poligon dengan warna putih

e Transparant faces, Membuat setiap poligon menjadi transparant

Measurement, Mengatur letak tampilan dan satuaan ukuran dari menu

meas, submenu berikut

e Home positions, Mengatur letak tampilan besaran dari meas di posisi
awal (kiri atas)

e Show unit, Menampilkan satuaan besaran dari meas.

Data, Menyimpan data measurement hasil dari perubahan parameter

dalam bentuk data array.

e Collect, Mengumpulkan data

e Inspect, Menampilkan data

e Width, Mengatur panjang karakter data

e Zero, Menghapus data

Thicken print, Mengatur ketebalan tambahan saat di-print

Solid arrowhead, Menampilkan ujung panah yang tegas

Simulprint, Mencetak beberapa file sekaligus

PiCTex file, Mengubah file ke dalam ekstensi *.tex

SVG file, Mengubah file ke dalam ekstensi *.svg, yang dapat digunakan

dalam grafik XML

Euler, Menampilkan data Euler.

Point  Linear Curved Units Transf Edit Meas Btns View Anim
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- Volume, Menampilkan volume bangun ruang yang kita buat.

File Point Linear Curved Units Transf Edit Meas Btns View Anim
Other  Help

wertices |ABCDEFGH

- Surface area, Menampilkan luas permukaan bidang lengkung

Point Linear Curved Units Transt Edit Meas Btns View Anim
r Help

werttices [ABCD

- Help, Menampilkan informasi tentang menu Other
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D. Aktivitas
Aktivitas : Melukis Kubus

Untuk melukis kubus digunakan menu Unit. Klik Unit - Polyhedral >
Prism. Masukkan banyak sisi alas prisma yang akan dibuat. Kubus berarti

prisma segi empat.

A noname} = 1=

number of zides |4 <25

lenath |2
height |2.00

bwild ‘ undo ‘ close |

Sisi prisma yang Anda buat akan diwarnai seperti gambar di atas. Tampilan
ini tentu tidak bagus untuk pembelajaran tiga dimensi. Anda dapat membuat
prisma yang transparan dengan cara klik View => Display kemudian pilih

dot hidden lines.

183




184

Kegiatan Pembelajaran 6

£ noname3

File Point Linear Curved Units  Transf Edit Meas Btns | View Anim  Other Help

D
Convexity assumed

Zoom

Rotate

Observer

Restore Chrl+w
Lask window

Labels
Axes
Markings

Help

Anda dapat menambahkan bidang pada kubus tersebut, misalnya bidang
BGE. Bidang BGE dibuat dengan klik Linear > Segment or Face kemudian

ketikkan bidang yang akan dibuat (BGE).

Painked
Painted and dotted
Ray-traced

v Dot hidden lines
Show hidden lines

v Outlines
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A nonamed

File Paoint  Linear Curved  Units Transf Edit Meas  Bins Yiew  Anim Other Help

new lnear elements

make a list

cancel

Dengan menu Linear ini juga Anda dapat menambahkan garis. Misalnya akan
dibuat garis yang tegak lurus dengan bidang EGB dan melalui D dapat
dilakukan dengan klik Linear = Perpendiculars - point to plane
kemudian isikan bidang (EGB) dan titiknya (titik D).
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£ noname3

draw altitude

perp to plane |EGE

fram paint ]
draw | undo | cloze |

Anda dapat memutar sudut pandang bangun ruang ini dengan menggunakan
tombol panah pada keyboard, dan mengunakan tombol PageUp dan

PageDown untuk zoom out dan zoom in.

Apabila Anda ingin membuat DF yang menembus bidang EGB, bisa
dialakukan dengan langkah berikut ini.

1. Pastikan di menu View, convectivity assume tidak aktif ditandai dengan
tidak ada tanda centang.

2. Buatlah garis DF dengan menggunakan menu Linear = Segment and
face.

3. Gunakan menu Point = intersection of point and - line
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£ noname3

File Point  Linear Curwved  Units Transf Edit Meas  Bins Wiew  Anim Other Help

intersection point

where segment IDF
meetz plane [3 vertices] IEGE

rnark. I undao | cloze |

E. Latihan

Lukislah sebarang balok dan tampilkan ukuran-ukurannya.
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Dynamic Geometry Software 4

A. Tujuan

Tujuan kegiatan pembelajaran ini adalah peserta dapat menggunakan menu

animasi pada Wingeom untuk membuat media pembelajaran.
B. Indikator Pencapaian Kompetensi

Setelah peserta menyelesaikan pembelajaran ini peserta dapat membuat

animasi untuk pembelajaran bangun datar dan kurva
C. Uraian Materi

Pada Wingeom terdapat menu transformasi baik pada 2-dim maupun pada 3-
dim. Menu ini digunakan untuk membuat transformasi geometri, seperti
translasi, rotasi, dilatasi, dan pencerminan. Transformasi yang telah dibuat
akan lebih menarik apabila dibuat animasinya. Pada kegiatan belajar ini akan

dibahas tentang pembuatan animasi dengan slider.
Transformasi

Pada menu Transf terdapat sepuluh submenu. Beberapa submenu akan

dibahas kegunaannya berikut ini.

1. Translasi.
Untuk melakukan translasi atau pergeseran, digunakan menu Transf =
Translate. Kemudian inputkan bangun/titik/garis yang akan digeser

(misalnya bangun ABC) dengan pergeseran sejauh 2, sepanjang vektor BA.
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A nonamed (A1)

File' Point Line Circlel Units Transf Edit Meas  EBtns  Yiew  Anim Other Help

vertices IABC
by the multiple |2

of wectar IB-&

ok | cancel

2. Dilatasi

Untuk melakukan perbesaran/dilatasi digunakan menu Transf - Dilate.
Misalnya akan dilakukan perbesaran vektor-vektor pada segitiga ABC dengan
pusat dilatasi titik C dan faktor perbesarannya 2. Untuk membuatnya
inputkan bangun/titik/garis yang akan diperbesar (ABC) dengan titik pusat

perbesaran C faktor perbesaran 2.
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A nonamed4 - 0O X

i

rotatesdilate

wveltices |.¢\BE
center |0
angle 0.0
factar |2

ak. | cancel

3. Rotasi

Untuk melakukan rotasi menu Transf 2 Rotate. Misalnya segitiga ABC akan
diputar dengan perputaran 90° dengan pusat perputaran titik C dan tanpa
perbesaran. Untuk membuat rotasi tersebut inputkan bangun/titik/garis
yang akan diperbesar (ABC) di kolom vertices dengan titik pusat perbesaran
C di kolom center faktor perbesaran 1, dan dengan sudut perputaran 90° di

kolom angle.
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A nonamed (A1)

File  Point Line Circle Units Transf Edit Meas  Btns View  Anim Other Help

rotatefdilate

vertices IABC
center IEi

angle ISU
factor |1 il

ok I cancel

4. Pencerminan

Untuk membuat bangun hasil pencerminan dilakukan dengan klik Transf -
mirror. Misalnya segitiga ABC akan dicerminkan terhadap garis DE,
dilakukan dengan menginput ABC di kolom vertices dan meinputkan garis

DE di kolom in mirrror.
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A nonamed - O X

File Poinkt Line Circle Units Transf Edit Meas Btns  Misw  Anim Other  Help

reflect

vertices IAEC
in mirror IDE

draw | undo | close |

Transformasi di 3-dim

1. Translasi
Misalnya kubus akan ABCD.EFGH akan digeser sejauh 1 dengan pergeseran
searah vektor AB, klik Transf = Translasi kemudian isikan seperti pada

gambar berikut.
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£ nonamel

UFI--—-\.____
i

vertices |.-’-'-.-H'

by the multiple 1.0

of vectar |AB

Proses transformasi di atas akan lebih menarik apabila dibuat animasinya
dengan menggunakan fasilitas slider di menu Anim. Pada menu terdapat

submenu berikut ini

# slider Digunakan untuk menjalankan animasi dengan # slider

$ slider Digunakan untuk menjalankan animasi dengan $ slider

@ slider  Digunakan untuk menjalankan animasi dengan @ slider

& slider Digunakan untuk menjalankan animasi dengan & slider
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Dengan submenu sebagai berikut

Set L

SetR

Reverse

Cycle

forward

Time
Vert at

Stop at

Digunakan untuk mengatur parameter paling kecil /paling kiri

Digunakan untuk mengatur parameter paling besar/paling

kanan

Digunakan untuk menjalankan animasi dengan mode mundur

secara bolak-balik

Digunakan untuk menjalankan animasi dengan mode maju

mundur secara bolak-balik

Digunakan untuk menjalankan animasi dengan mode berulang

secara terus menerus
Menjalankan animasi menurut pengaturan waktu
Mengatur titik yang akan mempunyai jejak dalam animasi

Mengatur kapan animasi berhenti pada parameter yang

diberikan
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D. Aktivitas
Aktivitas 1 : Membuat animasi rotasi
Misalkan akan dibuat animasi dari segi tujuh beraturan

Apabila bangun datar ABCDEFG dirotasikan dengan pusat titik H, cara

membuat animasinya adalah dengan langkah-langkah berikut.

1. Buatlah rotasi dengan menu transformasi seperti biasa, hanya saja pada

kolom angle diinputkan “#”.

A noname2 - O X

File| Point Line Circle Units| Transf Edit. Meas Btns  View  Anim Other Help

rotatersdilate

vertices I.t'-\-H

center IH
angle |ﬂ1
factar |1 0

ok I cancel
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2. Klik Anim > # slider kemudian atur parameter paling kecil dari slider.
Dalam hal ini slider akan dijalankan berdasarkan besar sudut
perputarannya. Oleh karena itu masukkan sudut paling kecil misalkan 0°
kemudian klik Set L, dan 360° kemudian klik Set R.

3. Animasi dapat digerakkan dengan menggeser slider

A\ noname2

setl | 123040000 set R
4 _ |
Ieverse ‘ cycle ‘ fonward | time |

vert at | |4, [ stop at |3.00000
cloze

E. Latihan

1. Buatlah animasi untuk menunjukkan Teorema Pythagoras berlaku pada
sembarang segitiga siku-siku. Gunakan fasilitas Btns = Drag vertices.

2. “Lingkaran adalah himpunan titik-titik yang berjarak sama dari suatu
titik tetap. Titik tetap ini dinamakan titik pusat lingkaran.”

Dari definisi lingkaran di atas buatlah animasi lintasan lingkaran.
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Pengenalan Latex

A. Tujuan

Tujuan kegiatan pembelajaran ini adalah Peserta dapat menggunakan LaTeX

untuk pengembangan diri dan profesinya.
B. Indikator Pencapaian Kompetensi
Setelah peserta menyelesaikan pembelajaran ini peserta dapat:

¢ menggunakan LaTeX untuk membuat dokumen sederhana,

e menggunakan LaTeX untuk membuat dokumen matematika.
C. Uraian Materi
Mengenal LaTeX

LaTeX adalah sistem penyiapan dokumen yangmempunyai format
terstruktur untuk menghasilkan dokumen ilmiah dengan kualitas tipografi
yang baik. LaTex menggunakan bahasa markup seperti halnya HTML, hanya
berbeda dalam sintaknya. Dengan menggunakan LaTex untuk membuat
suatu dokumen, seseorang tidak lagi perlu memikirkan struktur
dokumennya, sehingga bisa lebih fokus pada isi dokumen tersebut. LaTex
digunakan untuk komunikasi dan publikasi dokumen ilmiah dalam dunia

matematika, fisika, ekonomi, politik, dll.

Pengembangan LaTex dimulai pada tahun 1977 oleh Donald Knuth dengan
membuat sistem typesetting TEX, kemudian pada tahun 1980 Leslie Lamport
mengembangkan TEX menjadi LATEX. Saat ini digunakan LaTeX versi 2¢ dan

tahun 2014 mulai dikembangkan versi 3.
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Keuntungan menggunakan LaTeX

Beberapa keuntungan menggunakan LaTeX sebagai berikut.

1.

2.

Dokumen memiliki format yang terstruktur .
Penulisan formula matematika dapat dilakukan dengan mudabh.

LaTeX mengkondisikan penggunanya untuk membuat dokumen dengan
struktur yang baik dan benar, sehingga tidak terjadi kerancuan dalam
penulisan. Karena LaTeX mempunyai sintak penulisan yang sudah jelas

untuk diikuti dan digunakan penggunanya.

Otomatisasi pembuatan dokumen naskah seperti daftar gambar, daftar

tabel, Daftar Pustaka, footnote, daftar isi.

LaTeX merupakan software yang gratis dan dapat dijalankan pada

komputer multiplatform.

Pemformat dokumen LaTeX yaitu Text, dapat dijalankan pada mesin

komputer jenis apapun.

LaTeX dikembangkan dalam multibahasa.

Bentuk-bentuk pemanfaatan LaTeX

LaTeX digunakan untuk pembuatan dokumen-dokumen berikut ini.

Naskah umum

Naskah yang di dalamnya terdapat formula matematika.
Buku

Artikel ilmiah, jurnal.

Laporan penelitian, skripsi, tesis dan disertasi.
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Alat bantu penulisan dokumen LaTeX

Dokumen LaTeX merupakan dokumen polos dengan ekstensi .text. Dokumen
LaTeX mengandung sejumlah markup yang menandakan adanya format
tertentu. Untuk men-generate dokumen LaTeX menghasilkan suatu output
dibutuhkan suatu perangkat lunak yang disebut TeX distribution atau TeX
typesetting. TeX distribution adalah seperangkat perangkat lunak untuk
mengkompilasi dokumen TeX atau LaTeX . Ada beberapa TeX Distribution

yang tersedia untuk beberapa sistem operasi, yaitu:
e MiKTeX untuk sistem operasi Windows.
e TeX Live untuk sistem operasi Linux dan UNIX.
e MacTeX untuk sistem operasi Mac OS X

e proTeXt merupakan distribusi TeX yang berbasis MiKTeX

Untuk membuat markup dokumen LaTeX diperlukan alat bantu penulisan
dokumen LaTeX dalam bentuk editor LaTeX . Beberapa editor LaTeX

diantaranya sebagai berikut.

e Open source: AUCTEX, GNU TeXmacs, Gummi, Kile, LaTeXila, MeWa,
TeXShop, TeXnicCenter, Texmaker, TeXstudio, TeXworks

e Freeware: LEd, WinShell
e Proprietary/Shareware: Inlage, Scientific WorkPlace, WinEdt
Ada beberapa format output dokumen LaTeX yaitu:

e .DVI (device independent)

.EPS (format gambar berbasis vector)

e _HTML
e TXT
e .PDF
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D. Aktivitas
Aktifitas 1 : Membuat Dokumen Sederhana

Untuk membuat dokumen sederhana, langkah-langkahnya sebagai berikut.

1. Buka editor LaTeX
2. Ketikkan perintah berikut.
\documentclass{article}
\begin{document}
Guru Indonesia harus berkualitas dan berdedikasi...
\end{document}

3. Setelah dieksekusi hasil perintah di atas sebagai berikut:

Gurn Indonesia harus berknalitas dan berdedikasi. ..

Aktifitas 2 : Membuat Dokumen Matematika

Penulisan simbol matematika yang berada diantara teks harus diapit oleh

tanda $. Perhatikan contoh Perintah dengan kode latex berikut:
\documentclass{article}
\begin{document}

Tentukan syarat nilai $x$ vyang harus dipenuhi
supayasSy=\sqrt{\frac{x"2+3x-4}{x"2+x-2}1}$ bernilai

real.

\end{document}
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Setelah dieksekusi hasilnya sebagai berikut:

Tentukan syarat nilai = vang harus dipenuld supayay = %’% brernilad

real.

Untuk menuliskan rumus matematika yang terpisah menjadi baris sendiri
simbol matematika itu harus ditambahkan dua tanda $ di depan dan di

belakang simbol matematika.
Perhatikan perintah berikut:
\documentclass{article}
\begin{document}

Perhatikan persamaan berikut:

SSy=\sqrt{\frac{x"2+3x-4}{x"2+x-2}1}$5$

Tentukan syarat nilai $x$ vyang harus dipenuhi
supaya Sy=\sqgrt{\frac{x"2+3x-4}{x"2+x-2}}$

bernilai real.

\end{document}

Setelah dieksekusi hasilnya sebagai berikut:

Perhatikan persamaan berikut:

. 12+ Jr — 4
Y r4+r—2

Tentukan syarat nilai @ yang harus dipenuhi supaya y = :—:,'-"_':_L__;- bernilai

real.
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Aktifitas 3 : Membuat Dokumen Terstruktur dan Komentar

Untuk membuat dokumen terstruktur dan komentar, perintah kode

LaTeXnya sebagai berikut:
\begin{document}
\part{Google Drive}

\section{Google Form}% Layanan pertama GD yang

akan dijelaskan
\subsection{Membuat soal online}

\paragraph{Salah satu fitur dari Google Drive
adalah Google Form yang digunakan untuk membuat

form online.}
\end{document}

Hasil eksekusi perintah kode LaTeX di atas sebagai berikut:

Part I
Google Drive

1 Google Form

1.1 DMembuat soal online

Salah satu fitur dari Google Drive adalah Google Form yang digu-
nakan untuk membuat form online.

Terlihat pada hasil di atas, secara otomatis LaTeX mengatur penomoran
bagian-bagian dari dokumen. Komentar yang diketikkan pada bagian section

tidak tampak, karena komentar tidak ikut diekseskusi dan ditampilkan.
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Aktifitas 4 : Membuat Judul Dokumen

Untuk membuat judul dokumen perintah kode LaTeX sebagai berikut:

\documentclass[12pt,adpaper,oneside,english] {article}

\title{CLOUD STORAGE}
\author {Muda Nurul}
\date {2015}
\begin{document}
\maketitle

Google Drive mempunyai banyak

pembelajaran.
\end{document}

Hasil eksekusi menampilkan:

CLOUD STORAGE

Muda Nurul
2015

layanan

Google Drive mempunyai banyak lavanan untuk pembelajaran.

Aktifitas 5 : Membuat Paragraf

untuk

Membuat paragraf pada dokumen LaTeX menggunakan perintah sebagai

berikut:
\documentclass{article}
\begin{document}

\paragraph{Sapa pagi}
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Selamat pagi semua...selamat menikmati hari libur
bersama keluarga tercinta. Hari libur adalah momen yang
tepat untuk menambah kedekatan antar anggota keluarga

baik keluarga inti maupun keluarga besar.

\end{document}

Hasil ekseskusi menampilkan seperti berikut:

Sapa pagi Selamat pagl semua...selamat menikmati hari libur bersama kelu-
arga tercinta. Hari libur adalah momen yang tepat untuk menambah kedekatan
antar anggota keluarga baik keluarga inti maupun keluarga besar.

Aktifitas 6 : Menyisipkan Pemisah Baris
Contoh penggunaannya sebagai berikut:
\documentclass{article}

\begin{document}

Dropbox merupakan pionir layanan cloud
computing/komputasi awan yang cukup banyak
digunakan orang. Fitur vyang menjadi andalan

Dropbox adalah sinkronisasi data secara otomatis
melalui folder khusus Dropbox di desktop (Desktop
Sync Clients).

Fitur Dropbox yang sangat berguna lainnya adalah
adanya kemudahan berbagi folder data dengan orang
lain dan fitur push download secara otomatis cukup
dengan klik 1link download tanpa harus masuk ke

laman situs.

\end{document}




Modul Diklat Guru Pembelajar

Hasil ekseskusi seperti tampilan berikut:

Dirophox merupakan plonir layanan clond computing /komputasi awan yang
cukup banyak digunakan orang. Fitur yvang menjadi andalan Dropbox adalah
sinkronisasi data secara otomatis melalni folder khmsus Dropbox di desktop
{Deslitop Syne Clients). Fitur Dropbox yang sangat berguna lainnya adalah
adanya kemmdahan berbagi folder data dengan orang lain dan fitur push down-
load secara otomatis cukup dengan klik link download tanpa harms masuk ke
laman situs.

Pada perintah kode LaTeX di atas, meskipun kalimat “Fitur Dropbox yang
sangat berguna lainnya adalah adanya kemudahan berbagi folder data
dengan orang lain ..” menjadi baris baru, tetapi setelah dieksekusi
menghasilkan baris kalimat yang tidak terspisah dari kalimat sebelumnya.

Bandingkan dengan perintah kode LaTeX berikut dan hasil yang ditampilkan.
\documentclass{article}
\begin{document}

Dropbox merupakan pionir layanan cloud
computing/komputasi awan yang cukup banyak digunakan
orang. Fitur vyang menjadi andalan Dropbox adalah
sinkronisasi data secara otomatis melalui folder khusus

Dropbox di desktop (Desktop Sync Clients).
\linebreak

Fitur Dropbox yang sangat berguna lainnya adalah adanya
kemudahan berbagi folder data dengan orang lain dan
fitur push download secara otomatis cukup dengan klik

link download tanpa harus masuk ke laman situs.

\end{document}
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Pada pengaturan ini ditambahkan perintah LaTeX \linebreak. Hasil eksekusi

sebagai berikut:

Dropbox merupakan plonir layanan cloud computing/komputasi awan yang
cukup banyak digunakan orang. Fitur yang menjadi andalan Dropbox adalah
sinkronisasi data secara otomatis melalnd folder khusus Dropbox di desktop
{Desktop Svne Clients).

"Fitur Dropbox vang sangat berguna lainnva adalah adanyva kemndahan berbagi
folder data dengan orang lain dan fitur push download secara otomatis culup
dengan klik link download tanpa harns masuk ke laman situs.

Hasil menunjukkan kalimat setelah \linebreak menjadi baris baru terpisah

dari baris sebelumnya.
Aktifitas 7: Environment
Membuat kalimat center

Perintah kode LaTeX untuk membuat posisi kalimat berada di tengah sebagai

berikut:
\documentclass{article}
\begin{document}
\begin{center}
Hari ini adalah hari libur.\\
Banyak aktivitas yang bisa dilakukan di hari libur.\\
Baik aktivitas pribadi atau bersama keluarga.
\end{center}
\end{document}
Setelah dieksekusi menampilkan hasil berikut:
Hari ini adalah hari libur.

Banyal aktivitas vang bisa dilakukan di hari libur.
Eaik aktivitas pribadi atan bersama keluarga.
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Membuat daftar berurutan
\documentclass{article}
\begin{document}
Makanan dan minuman kesukaanku adalah
\begin{enumerate}
\item Kopi
\item Susu
\item Pempek
\item Bakso
\end{enumerate}
\end{document}
Setelah dieksekusi menampilkan hasil sebagai berikut:

Makanan dan minnman kesukaankn adalah
1. Kopi
2. Susu

3. Pempek
4. Bakso

E. latihan/tugas

1. Apayang Anda ketahui tentang LaTeX ?
a. LaTeX adalah pengolah kata biasa yang dapat menghasilkan berbagai
format dokumen.
b. LaTeX adalah suatu sistem bahasa markup yang mempunyai aturan
tetap.
LaTeX adalah sistem penyiapan dokumen dengan format terstruktur.
d. LaTeX adalah sistem dokumen yang dapat menghasilkan berbagai

format dokumen.
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2. Berkaitan dengan dokumen LaTeX, pernyataan manakah yang tidak
benar?
Dokumen LaTeX merupakan dokumen polos dengan ekstensi .text
b. Dokumen LaTeX menggunakan bahasa markup dengan format
tertentu.
c. Dokumen LaTeX merupakan dokumen TeX yang dapat di-generate
menjadi dokumen pdf
d. Dokumen LaTeX merupakan dokumen polos dengan ekstensi.doc
3. Perangkat lunak yang digunakan untuk mengkompilasidokumen LaTeX
adalah ....
a. Text distribution
b. Text processor
c. Texteditor
d Text converter

4. Typesetting untuk sistem operasi Windows adalah ....

a. MiKTeX
b. TeX Live.
c. MacTeX
d. TeXt

5. Jika Anda hendak membuat dokumen berbentuk jurnal, maka class

dokumen yang Anda gunakan adalah ....

a. Book
b. Article
c. Letter
d. Slide

6. Perintah untuk mengubah bentuk font huruf menjadi tebal adalah ....
a. \textbf
b. \underline

c. \Huge
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d. \Large

7. Environment untuk menuliskan daftar berurutan adalah ....

a. enumerate
b. itemize

c. flushright
d. flushleft

8. Untuk menghidupkan mode matematika di mana persamaan matematika

10.

11.

menjadi baris sendiri terpisah dengan teks sebelumnya menggunakan

simbol ....
a. $

b. $$

c. &

d *

. Kode LaTeX untuk integral adalah ....

a. \int

b. \sum

c. \times

d. \div

Dokumen LaTeX dapat dikonversi menjadi dokumen-dokumen berikut,
kecuali ....

a. .PDF

b. .EPS

c. .DVI

d. .DOCX

Perintah \hline digunakan untuk membuat ....
garis horizontal

b. garis vertical

c. garis putus-putus

d. garis tebal
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F. Rangkuman

LaTeX adalah sistem penyiapan dokumendengan format terstruktur.
Penulisan kode LaTeX menggunakan bahasa markup. Dokumen LaTeX
merupakan dokumen polos dengan ekstensi .text. Untuk mengkompilasi
dokumen TeX atau LaTeX digunakan perangkat lunak TeX distribution.
Proses pembuatan dokumen LaTeX dimulai dengan mengetikkan kode LaTeX
kemudian dikompilasi menggunakan TeX distribution dan kemudian di-
generate untuk menghasilkan output dokumen dalam format .pdf atau .eps
atau DVI. LaTeX biasanya digunakan untuk membuat dokumen-dokumen
ilmiah seperti jurnal, disertasi, karena LaTeX dapat menghasilkan tipografi
yang berkualitas baik. LaTeX juga dapat digunakan untuk menghasilkan

simbol-simbol matematika.
G. Umpan Balik dan Tindak Lanjut

Setelah Anda mempelajari materi dan mempraktikkan aktivitas
pembelajaran silahkan mencoba menjawab latihan. Cocokkkan Jawaban
Anda pada kunci jawaban. Jika Anda masih kesulitan dalam mengerjakan
aktivitas pembelajaran Anda bisa membaca kembali uraian materi di
kegiatan pembelajaran ini. Jika Anda dapat menjawab pertanyaan dengan
betul pada latihan tersebut berarti Anda sudah menguasai materi yang ada di
modul ini dan dapat melanjutkan mempelajari modul berikutnya. Jika belum
terselesaikan semua, ulangi kembali untuk dapat memahami materi yang

disampaikan.

H. Kunci Jawaban

1. ¢ 7. a
2. d 8. b
3. a 9. a
4. a 10.d
5 b
6. a
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